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General Information
This chapter provides some general information on the product.

Changes from previous version
Changes made to this manual from its previous version are marked with underlined text.

Trademarks
VICTOR™ and Wallac™ are trademarks of PerkinElmer, Inc.

Windows®, Windows® 10 and Excel® are registered trademarks of Microsoft Corp. in the U.S. and other countries.

Copyright © 2015-2022, PerkinElmer, Inc. All rights reserved. PerkinElmer® is a registered trademark of PerkinElmer,
Inc. All other trademarks are the property of their respective owners

Intended purpose
The VICTOR2™ D fluorometer is intended for time-resolved and prompt fluorescence analysis of samples in 96-well
microtiter plates. The instrument is used in combination with IVD assays whose instructions for use list it as compatible.
The function, specific disorder, condition or risk factor to be identified, the specimen type and the testing population
are based on and described within the intended purpose of the applicable assay. The VICTOR2™ D fluorometer is
intended to be used by trained laboratory personnel.

Conditions for use of the software and this manual
This user manual forms part of the PerkinElmer 1420 D product.

The Software License Agreement, which is supplied with the product, governs the conditions for use of the entire
product, including the manual.

With regard to the user manual, sections within the agreement with particular relevance include those marked,
COVENANTS OF LICENSE, LIMITED WARRANTY AND REMEDIES, and LIMITATION OF LIABILITY.

Installation and system requirements
The PerkinElmer 1420 D software runs on Windows® 10.

Overview of software modules
The VICTOR² D Workstation software suite consists of the following modules:

The Kitlot Editor module allows you to maintain information about kitlots and other parameters of your assays.

The 1420 D Instrument Control is a module that allows you to control the VICTOR² D instrument.

The Result Viewer module allows you to review the results of your assays and mark the results to be reported or
repeated

The Quality Control module allows you to define your quality control rules and limits and to do long term monitoring
of your quality control data.

The Plate Generator is a module which allows you to create plate data manually instead of transferring the data from
another software.

Data Server Test and Security Manager are intended for service use only.



Table of symbols
Refer to your product instrument manual for information on symbols that appear on the instrument, on the package or
in other labelling material.



Safety information
This section contains information related to the safety of the product.

Conventions
The following conventions are used in all system documentation:

Warning: A warning indicates a hazardous situation or operation that, if not avoided, could result in serious personal
injury or death to the operator or the patient. Follow all stated precautions.

Caution: A caution indicates an operation that could cause damage to the instrument or loss of data, or personal
injury to the operator or the patient if correct procedures are not followed.

Note: A note emphasizes significant information in a procedure or description, and alerts users to key points of interest
not related to personal injury.

In cases where a specific hazard or warning has been identified – such as an electrical or burn hazard – that symbol is
added to the cautions and warnings.

Warnings and precautions
Also consult the "Warnings and precautions" section in the Instrument Manual.

Warning: Back up the database to an external drive or media on a regular basis to minimize the risk of data loss.

Warning: This product is equipped with a security system that allows only configured users to access the system. The
software prevents the editing of the same data by multiple users at the same time.

Warning: The instrument and computer may only be used by trained laboratory personnel.

Warning: Only the PerkinElmer factory-made protocols with default parameters and predefined assay configuration
settings are validated for diagnostic use. See the "Factory-made protocols" section in the Instrument Manual.

Warning: To ensure data security, log off from the computer whenever you leave it. Also, use the Windows screen
saver with password and timeout (e.g. 10 min) to protect the data if a user accidentally forgets to log off.

Caution: PerkinElmer recommends that you do not connect the PC to a local area network, (LAN). If you do connect it
to a LAN,use adequate virus protection and firewall. Make sure the LAN settings do not interfere with the measuring
process of the PerkinElmer 1420 D Fluorometer.

Caution: Do not connect a memory stick into a USB port of the workstation PC unless you know that the memory
stick is free of viruses.

Caution: Do not install other applications on the PC because they may interfere with the operation of the instrument
or the handling of data.

Caution: Do not change the Windows operating system settings. They are pre-set at the factory.

Note: To avoid confusion between patient and control samples, please use different sample code format for control
samples and patient samples.

Note: Ensure that your laboratory uses valid cut-off values. Take the best available professional advice in this.

Notice regarding serious incidents
For a patient/user/third party in the European Union and in countries with an identical regulatory regime (IVDR; EU
2017/746/EU); if, during the use of this device or as a result of its use, a serious incident has occurred, please report
it to the manufacturer and to your national authority. The contact information for the manufacturer of this device to
report a serious incident is:

Wallac Oy

Mustionkatu 6, FI-20750 Turku, Finland



http://www.perkinelmer.com

Phone: +358 2 2678 111

http://www.perkinelmer.com
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kit lot information



About Kitlot Editor
Kitlot Editor provides a straightforward means of entering new kit lot details. Additionally, the module allows reference
curves to be built from existing calibration curves and pre-defined cut-off limits to be edited.

Kitlot Editor
About Kitlot Editor
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Using Kitlot Editor
Kitlot Editor is an application that provides functions to manage the system configuration.

You will run Kitlot Editor, for example, when you start to use a new kit that your laboratory has received.

In the main view of the Kitlot Editor, there is an Assay Run Definition list on the left. It contains the run definitions that
have been activated in your system.

See the section How to Activate Assays on page 12 for instructions on how to add new run definitions to the list.

To the right of the list there is a list of the kit lots of the currently selected assay run definition. The currently active kit
lot is highlighted in the list with bold font.

On the right side of the main window there is detailed information on the kit lot (kit lot Name, Plate lot id, kitlot
Expiration date, and Other lots data) and about calibrators (calibrator lot id, the calibrator unit, and the concentration
value of the named calibrators).

How to activate a kit lot is explained below (see How to set a kit lot as active on page 13).

The program has considerable functionality to support specialized users. For routine users, less functions are available,
so when you open the program, you may find that the New and Delete toolbar buttons, and the fields on the right side
of the main window are disabled, and not as they appear in the previous picture.

Kitlot Editor is also used to launch the Reference Curves utility, which allows you to build reference curves from existing
calibration curves (see Reference curves utility on page 19).

Kitlot Editor
Using Kitlot Editor
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Entering kit lot details
You can either enter new kit lots manually or, if the lot information is provided as barcodes on the Quality Control
certificate, you can use the Certificate Read utility. It provides an easy and time-saving means of entering kit lot
information. This is available from the Kitlot Editor main window.

How to Activate Assays
Before you can start to use an assay you need to activate it. Activation is done by entering product information from the
QC certificate that comes with the reagent kit. See the UDI code in the QC certificate and note the sequence of numbers
between (01) and (17).

Then in Kitlot Editor press the Certificate button from the main screen and Activate Assay button from the certificate
reading dialog. Then enter the code that you noted from the QC certificate.

How to enter a new kit lot
The information to be entered comprises the kit lot number, coded concentrations and expiry date for the kit lot. This
information is found on the Quality Control Certificate that is inside every kit pack. Use the Quality Control Certificate
from the first kit of the new lot.

1. Either click the New toolbar button or select New from the Kitlot menu
2. In the Add New Kitlot box, type the kit lot number. The OK button will become active when you start to type.

Kitlot Editor
Entering kit lot details
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3. Click the OK button
4. Enter the Plate lot and Calibrator lot if that information is available for the kit.
5. If you wish to specify alternative units for the calibrators, click the field where the existing unit is shown. A

dropdown menu will appear only if there are any alternative units that can be specified.
6. Type into the respective fields the exact values for the calibrators; pay close attention to the unit used.
7. Set the expiry date either by typing it into the field or click the arrow to the right of the field, and select the date

from the dropdown calendar
8. If your kit contains additional lot information, enter it in the Other Lots list.
9. Finally to save the settings you have made press the Save button on the toolbar or click the Save item from the File

menu

How to set a kit lot as active
One kit lot may be active for a particular assay run. If a lot number is not communicated by the measuring instrument,
then it is assumed that the run is using the active lot. In Kitlot Editor this is marked in bold in the Kit Lot column in the
middle of the window.

1. To make a kit lot the active one, select it by clicking. The Set as Active button will become active.
2. Click the Set as Active button.

How to scan certificate barcodes
This is only possible when the lot information is provided in a barcoded format on the kit QC certificate.

1. Either click the Certificate button or click the Certificate menu item from the Kitlot menu.
2. When the Read Certificate dialog box opens, scan the barcodes (according to the instructions for the barcode

scanning device)

The certificate may contain one or multiple barcodes either as a traditional one-dimensional barcode or a two-
dimensional barcode. If there are several barcodes you will probably find it easiest to scan the barcodes in the order
that they are listed, however the system will accept them in any order. After you have scanned one, the barcode that
has been scanned is shown in the lower part of the dialog [A], and information on which of the barcodes have been
scanned so far is shown in the status bar at the foot of the dialog box [B]. The Save button becomes active when all
of the barcodes have been scanned [C].

Kitlot Editor
Entering kit lot details
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Once all the barcodes on the certificate have been read, the application will show information according to the type
of operation you are performing:

If you have scanned a new kit lot, the application will display the kit lot number and the expiration date

If you have scanned an existing kit lot, the application will show a comparison between the current configuration
and the data from the QC certificate

Note: The popup window limits the amount of text that may be shown. To view any text that may be truncated,
select the appropriate row and a tool tip - with all of the text in that row - will appear.

Prior to accepting and saving the QC certificate information, users may also change the units to be associated
with the selected analyte/kit. To change the units, select the "Certificate Units" row and select the desired units of
measurement or type in your preference.

If the selected or entered unit is not valid a message box indicating this is shown and the currently used unit is reset
in the grid. It is also possible to postfix the unit either with B (blood) or S (serum). The unit used in the certificate is
indicated in the "Certificate Units" row in the lower grid. Once the unit is set the certificate data can be saved.

3. Save the whole certificate by clicking Save

Confirmation of the save will appear in the status bar

You will normally wish to save the whole certificate as it is. However if there is more than one assay run definition,
you can select which one is affected.

4. Make any such changes by checking or unchecking the respective assay run definition shown in the grid

If the certificate covers only one assay run definition, the Assay Run definition column in the Read Certificate dialog box
is not shown.

Kitlot Editor
Entering kit lot details
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Assay parameters
Kit lot editor allows you to edit some of the assay run definition properties, and pre-defined cutoff limits.

How to edit run definition properties
Editable properties include the reportable display name of the Test, the format of the concentration, as well as the
reporting limits.

1. Under the Assay menu, select Properties.

The Assay run definition properties box will open.

2. Specify the Analyte Display Name.

The chosen name is saved as the display name of the analyte and test. For more on display name, see Assay Master
Configuration on page 23

3. Specify the concentration format.

• Use the symbol 0 to define the number of decimals (e.g. to use always two decimals as in "12.30", use the
format: 0.00).

• Use the symbol * to define the number of significant figures (e.g. to have three significant figures "12.3", use the
format: *** ).

• Use the letter Z in the concentration format to force negative values to be printed as 0 (use the format: 0.0 Z ).
• So for instance, in order to have 3 significant figures with maximum 2 decimals and avoid negative

concentration values, use the following value for the Concentration Format: 0.00 *** Z.
4. If needed, edit the reporting limits.

Either or both of them can be left blank. When given limits are outside the values in the Kit lot then the calibration
scale values are set according to values given here.

The concentration unit can be edited with the following restrictions:

• You can use the B or S designation to indicate Blood or Serum, otherwise the software uses the unit assigned to
the kitlot.

• You can change the SI prefixes of the unit but you cannot change the actual unit. For example you can change
ng/mL to mg/dL but you cannot change ng/mL to nmol/mL .

5. Assay specific parameters can be edited if there are any. Examples:

• Unkn CV% Limit: Set this to a non-zero value to enable flagging of results which exceed the given CV% value.

Kitlot Editor
Assay parameters
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• Patient Replicates: Number of replicates to run from patient samples.
• Control Replicates: Number of replicates to run from control samples.
• Dilution Factor: Dilution factor to use for all samples except calibrators. 1 means no dilution.

How to edit predefined cutoff limits
1. Under the Assay menu select Cutoff Limits.

The Edit Cutoff Limits dialog box will open. Click Save to activate the limits.
2. Enter cutoff values in ascending order for initial results and retest results.

Note: "Ascending" here means increasing cutoff values when a column is filled from top to bottom.

There are two cutoff values for both initials and retests since the cutoffs separate three categories, normal,
borderline and presumptive positive. For example, hTSH-I-60 is presumptive positive, thus the first value is the
cutoff between presumptive positive and borderline.

3. For change traceability reasons, if you make changes to the cut-offs, you will need to provide your name and the
reason for the change before the Save button becomes available. This helps keep tracks of who made changes
when using a common Windows user (i.e. Administrator, etc.).

If there are changes to be saved the Save button is enabled.
4. Click Save to confirm the editing carried out

To print the limits, click the Print button.

You can also modify the list of possible result categories. If you have permission to edit them, there is a pen icon next to
the assay name.

Click the cell with the assay name and the pen icon and a dialog opens where you can edit the settings.

The list shows the categories that will be assigned to the results. Categories are sorted by concentration, with the
lowest at the top of the list, i.e. if normal results have low concentration, then the Normal category will be at the top of
the list, but if normal results have high concentration, the Normal category will be at the bottom of the list. Each test
phase has its own tab, so you can set different parameters for each. The table below offers a brief explanation on each
of the grid column:
Determination The result category. To rearrange their order, drag the cell up or down.

Equality This setting affects the comparison operator. If checked, the operator is >=. If
unchecked, the operator is >.

Limit type This setting defines the type of cutoff value (concentration or statistical value). Possible
types:

• Fixed: the cutoff value is a concentration
• Percentile: the cutoff value is a percentile rank within the assay
• %M: the cutoff value is a percentage of median within the assay

Result Code The internal name of the result code that will be assigned to the results.

Display Name The name of the result code shown to the users.

Kitlot Editor
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To modify the list of determination groups shown for each test phase, click Select Determinations. For instance,
you can choose the initial test phase to include normal, borderline and presumptive positive groups, while the retest
phase only includes normal and presumptive positive groups. The table below offers details on the settings that can be
edited:
Color The color used to indicate the determination category. It can be used e.g. in the result

grid as cell color.

Initial/ Retest If the determination does not apply to a test phase, leave all the checkboxes blank.

Name The unique internal name of the determination level.

Display Name The name of the determination level shown to the users.

How to change Sample layout
Sample layout and location of Calibrators and Controls can be permanently defined to be available in Plate Generator
or SPW import.

1. Under the Assay menu, select Sample map.
2. Define your Control level names. Names must be unique within the Assay definition.

3. Select the plate map to be defined for later use. Notice that SPW can use only Plate Map 1 and 2. Plate Map 1

contains Calibrators while Plate Map 2 does not. 
4. For each plate you can set Plate Maps to be defined independently, or to be the same as another existing plate.

5. To define Special End Controls, use the button >|.

Place End Controls at the beginning of the plate to be a list of samples to end the assay. These controls are placed
on the next free patient wells and they will replace any further controls on remaining positions.

6. Mark one or more wells, release the mouse button and select the desired Sample definition on those wells. <Empty>
are not used at all. <Unknown> are for patients. Letters A-F are for Calibrators and other texts are Control samples.

7. To save the sample definitions, click OK. To discard those changes, click Cancel.

To change the number of calibrators for user-created assays, press the Change Calibrator Count and adjust the
number as needed.

Kitlot Editor
Assay parameters
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Managing Control Materials
To manage control materials, click the Controls toolbar button. The Control Materials window opens.

To add new materials, click New to create from scratch or Copy to copy the selected item. To delete materials, select in
the list the item you want to delete and click Delete.

To set the expiration date and/or vendor code, click on the field you want and set it as appropriate. When you select a
material from the list, the fields in the right side of the window are populated with the list of assays that can be used
with the selected material.

You can also filter the assay list by instrument if needed.

In order to start using the material with an assay, click the corresponding cell in the QC level column and select the
control level from the dialog that appears.

If you need to add a new level, enter the information for the new level on one of the empty rows.

Kitlot Editor
Managing Control Materials
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Reference curves utility
The Reference Curves utility allows management of the calibration curves associated with a kit lot. In particular it is
used to build reference curves by summing existing calibration curves that are deemed suitable.

Whenever a kit lot with calibrations is selected, the Reference button on the toolbar and the Reference Curves item in
the Actions menu are enabled.

How to build a reference curve
Either click the Reference toolbar button or select Reference Curves from the Kitlot menu.

The Reference Curves screen consists of three main sections.

These allow you to:

• Filter a range of calibration curves [A]
• Pick out the suitable curves and sum them to form a reference curve [B]
• Review the calibration curves, the summed curve, and the reference curves [C].

Filter pane
To set filters, you first need to specify the test.

Click the arrow next to the Test: box and choose from the dropdown menu. It is only necessary to do this if there is
more than one test for the kit lot.

For the specified test, you can now choose the period for the creation dates of calibration curves. There are Date: boxes
for the beginning and end of the period.

Click the arrow to the side of one of the date range boxes to specify a date from the drop down calendar. When you
select a date, the checkbox to the left of the date field will be marked as checked.

If you wish to specify an open-ended period, for example, any time before a specified date, make sure that only the
specified date is checked.

The Instruments: list allows filtering of calibrations created with specific instruments. By default all instruments are
checked.

Uncheck an instrument from the list to remove the calibrations created with it from the calibration curve list.

In addition to the filtering options described, there is a checkbox to select whether all curves used to calculate the
current reference curve of the selected test should always be shown in the calibration list regardless of date or
instrument filtering options.

Kitlot Editor
Reference curves utility
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Calibration curve pane
The calibration curve selection list contains all curves of accepted calibrations that fit the specified filtering options. The
font colors represent the color of the curve on the curve viewer.

The following information is shown for each curve.

• Selection status: Checkbox indicating either that the calibration curve is selected for summing (when checked) or
not (when unchecked)

• Curve: Name of the calibration curve
• Status: Indicates whether the curve has been used to create the current reference curve (status text "Used") or not

(status text "Unused")
• Instrument: Instrument name, "<N/A>" is shown if no instrument name has been specified
• Date: Creation date of the calibration curve

Below the calibration curve selection list there is information on the current reference curve (if there is one).

Select the calibration curves for summing by checking the selection status checkboxes.

Selected curves are displayed in blue font. When at least two curves are selected, the curves are automatically summed
to create an average of selected curves, and the summed curve is shown on the curve viewer. The text "Average of
selected curves" appears under the calibration curve selection list and the New Reference Curve from Average and
Export buttons are enabled.

The New Reference Curve from Average button is used to store the summed curve as a new reference curve.

Click the New Reference Curve from Average button.

In the Create New Curve dialog box to enter a name for the new reference curve.

The default name for the new curve consists of the index number of the reference curve and the number of curves
summed to create the curve separated by a hyphen (-). When a curve has been named it is created replacing the
previous reference curve.

The Export button is used to export the data of the summed curve in a binary file. You will be prompted to enter a path
and name for the file to save the exported curve data in.

Curve viewer pane
The curve viewer is used to review the calibration curves, the average curve created by summing selected calibration
curves, and the existing reference curves.

Above the curve display there are options to select which curves (in addition to the calculated average curve) are shown
on the curve display.

The possible choices are

• Current reference curve and selected curves
• Current reference curve
• All reference curves

Select one of these options. Depending on the chosen option the corresponding curves are shown on the curve display
using the following color coding.

• Black bold curve: Calculated average curve, or if not enough curves have been selected to calculate one, the current
reference curve

• Gray curve: Current reference curve, if an average curve has been calculated
• Black curve: Other reference curves
• Blue curve: Selected calibration curves

When you are satisfied with the reference curve you have created, click the OK button. The new curve will be saved and
the Reference Curves utility will close.
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If you wish to abandon your changes at any earlier stage, you can do so by clicking the Cancel button. The utility will
then close without any changes being saved.

Once the Reference Curves screen is closed, the main window of Kitlot Editor becomes active again.

The Reference Curves screen can also be closed by clicking the Close button in the top right corner of the window.

If there are any new reference curves that have not been stored to database, an exit confirmation dialog box is opened
which asks whether you wish to save the changes made.
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Additional functionality for managing kit lot information

How to reset changes
You can undo the changes made to the properties of the selected kit lot before any other kit lot is selected for editing
(or the Save button is pressed).

Either click the Reset toolbar button or select Reset from the Kitlot menu.

How to delete a kit lot
When a kit lot is deleted, all test lots and calibrations under it are also deleted. If the deleted kit lot is the active kit lot
for the assay run, then the first kit lot of the remaining ones is set as the active kit lot (unless the deleted kit lot was the
only kit lot for this assay run).

1. First select the kit lot to delete
2. Either click the Delete toolbar button or select Delete from the Kitlot menu
3. Confirm the deletion by clicking OK

How to Create Your Own Assay Configurations
You can create assay protocols by cloning one of the protocols that come with the product and then modify its
properties. These cloned assays can be modified further than the ones that come with the product.

How to Clone an Assay Configuration
Depending on your user permissions, you can create a new assay by cloning one of the existing assays and giving
the cloned assay a new name. There are then more options to modify these cloned assays than the default factory-set
assays. Only single label assays can be cloned.

To clone an assay,

1. select it from the main screen and then click Clone command from the Assay menu.

2. enter a new unique name for the cloned assay and choose how its test is configured.

Every factory-set assay has its own test, which means that each one has its own cutoffs and its own repeat lists. As
you clone the assay you can choose from one of these options:

• Share the same test as the assay from which this assay was cloned. Choose this option if the new assay can share the
original assay cutoffs and repeat lists.

• Create new test. Choose this option if your assay needs its own cutoffs and repeat lists. The name of the new test
will be same as the name of the new assay.

• Use no test. Choose this option if your new assay does not need cutoffs or repeat lists at all.
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Assay Master Configuration
You can use the assay master configuration tool to edit the main properties of the assays. This tool is opened from the
File menu Assays option. Name property is not editable for any of the assays. All the other properties can be edited for
assays that user has created by cloning. The assays that come with the product have some of the properties locked.
These locked cells have gray background.

The list of assay properties available:
Table 1: List of available assay properties

Name Unique internal name of the assay. This column can also be used for sorting the list.
Drag this cell up or down with your mouse to move this assay higher or lower in the list.

Display Name (Editable) The name of the assay as shown to the user. By default this is also used as the
name of the worklist and export file names.

ExtCode Internal numeric ID of the assay which links to the measurement protocol ID to be
used by the instrument. This is also used for identifying the assay for a QC certificate
barcode.

ID in Plate Numeric ID that is used for identifying the assay from the plate barcode.

Programming Name of the assay calculation project. Used only if the assay has some specific
calculations. The project called "Default" which comes with the product does not
contain any calculations.
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Layout (Editable) Name of the result grid layout used in Result Viewer for this assay. The same
layout can be used by multiple assays.

Description (Editable) Free description of the assay. This can be included in the ID line (Header) if
the assay is exported in MultiCalc format.

Protocol Name Not used. Instrument protocol is selected based on ExtCode

Curve Fitting Parameters
In order to change calibration curve parameters of a cloned assay you need to run one plate of the cloned assay and
then modify the parameters in Result Viewer. See section "How to view calibration properties" in the Result Viewer part
of this manual.
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Instrument Control
Instrument Control for 1420 D is an program intended for routine users to measure plates on the VICTOR² D
instrument.

Note: For optimal performance, it is recommended to keep the instrument running at all times and not to switch it off.

Using the application
Before starting the program, ensure that the instrument is powered on and that no other instrument software is
running (1420 D Manager or 1420 D Service Program). During program startup, it will initialize the communication with
the instrument and will show a progress window.

Once the initialization is complete, the Instrument Control main display will appear in a small window. This window will
remain open at all times while the application is running.

Operation Modes
There are two main operation modes: the worklist mode and the assay mode.

Instrument Control
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The worklist mode is practical when the plates are identified using unique barcodes and the information of the well
samples has already been recorded, for example by a dried blood spot puncher. In this mode, the user loads a
barcoded plate into the instrument, that in turns reads the barcode and locates the corresponding worklist without
user input. It then performs the measurements based on the worklist information. This mode is useful only if your
instrument is equipped with an internal barcode reader.

The assay mode needs to be used whenever the plates do not have unique barcodes. In this mode, the user instructs
the software how to measure the plate before loading it into the instrument. The instrument then performs the
measurement based on that input.

Worklist Mode
There are two ways to set the plate identification:

• Let the instrument read the plate barcode. To do this, click Use instrument internal barcode reader and proceed.

Note: Even with the internal barcode reader option, the plate's barcode must be in the list, otherwise the
instrument displays an error message and the plate loading operation is aborted.

• Select the plate barcode manually from the list of available plates. To do this, click Select from list of punched
plates

If you opted to select from the list, click the arrow to the right of the field to see the dropdown list and select the
desired plate barcode.

The list of plates includes all punched, measured and calculated plates of the tests that can be measured with the
instrument.

Note: When selecting the plate barcode from the list, the instrument will nevertheless read the plate barcode to
check it. If the barcode on the plate does not match the selection, the measurement will not continue. To proceed
with the selected barcode, you must remove or mask the barcode label before loading the plate.

Note: A plate can be re-measured any number of times as long as its assay is in the list.

To prevent the instrument from sending individual plate results once they are measured and instead combine several
measured plates into one single assay, select the Allow multiple plates to same assay checkbox. Always check this
box when using stacks of plates in multiplate assays, otherwise each plate will be considered as being part of its own
assay and you will have to press the instrument LOAD button between each plate measurement.

How to proceed

Having set the plate identification, you are ready to work with the VICTOR instrument.

Load the plate into the instrument and press the instrument LOAD button.

The Instrument Control main display will update to show you details of the assay and the measurement status.

Assay Mode
There are three ways to start the run in assay mode.

1. Click Select Assay to choose an assay which already exists in the system.
2. Click Create new assay to manually create new assay for the plate.
3. Click Import worklist to choose a worklist file which tells the contents of the assay.

Select Assay

Clicking Select assay opens a dialog listing all the possible existing assays. Select the correct assay from the list and
click OK.
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Create New Assay

Clicking Create New Assay opens a dialog where you can provide information about the assay.

First you need to choose the assay name from a list of configured assays. Then you need to provide the name of the
first sample. You have then three options to tell the length of the assay:

1. Number of samples, the plate maps are filled then with as many samples as instructed.
2. Number of wells, either just as a number or from a separate selection dialog where you tell how many plates there

are and what is the last well of the last plate.
3. Last sample name, system will then calculate from the name that how many samples there are in total. This option

naturally requires that both the first and last sample use similar naming convention with a number in the end of the
name. So for example if the first sample is called P001 and last is P050 then there are 50 samples in total.

In all of the above cases the number of patient replicates is taken into account. So for example in case of 10 samples
and patient replicates setting of 2 a total of 20 wells will be expected. Note that when giving number of wells with a
replicate count higher than 1 you need to ensure that the number of wells is divisible by the number of replicates.

There are also two optional properties that you can provide for the assay, Batch ID and Run ID. These are just
information that will be stored with the assay but they do not affect how it will be processed.

Import Worklist

Clicking Import worklist opens a file selection dialog to choose the worklist. It must be in a MultiCalc format in order
to be imported correctly. The assay name and Run ID will be taken from the worklist file name and extension. For
example a file called NTSH.W01 means that assay name is NTSH and Run ID is 1.
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How to proceed

After defining your assay, you are ready to work with the instrument.

Load the plate into the instrument and push the LOAD button on the instrument.

The Instrument Control main display will update to show you details of the assay and the measurement status.

Test Mapping
Assay name shows the name of the test as listed throughout the VICTOR² D Workstation calculation modules and
Instrument protocol shows the name of the VICTOR measuring protocol.

Status
You can see both Instrument Status and Plate Status as the process is going on.

The plate image is also updated during the process; the color of the wells change as they are being measured. There
are two different ways to color the wells. First option is to color them based on the measured counts value with a
color ranging from blue (low values) to red (high values). The Scale drop-down list provides different scaling ranges to
choose from in order to have an informative color scale for the measurement protocol that is being used.

The other alternative is to color the wells based on the specimen role. In that case the wells are first colored with a light
shade color indicating the specimen role and once the well has been measured it turns into a deeper shade.

The Legend section on the right side of the plate image shows how the colors should be interpreted.

The plate image has an X mark on one of the wells indicating the last well that has a sample in it.

How to stop measurement and how to close the application
The Stop button on the main display is only active when the VICTOR instrument is measuring.

1. Click the Stop button to stop measurement

The plate will be unloaded and no results transferred.

Closing the application is not possible while measurement is running.
2. After measurement is complete, click the Exit button

Note: The instrument server is unloaded as this application ends.

How to resend results
You can resend results that have not previously been transferred successfully. This option is not available while
measurement is running.

1. Click the Resend button

The Select Plates to Resend dialog box will open. It includes a list of plates identified by barcode and RunID which
are not transferred to VICTOR² D Workstation.

2. Check the plates that you wish to transfer; leave unchecked the plates that you wish to remove from the resend list
without transferring

3. Click OK

If, instead of OK you click the Cancel button, the window will close and nothing is transferred or removed.

Using the instrument
Before measuring the plate, ensure that the instrument is powered on, the 1420 D Instrument Control program is
running and the "Load" button on the instrument is blinking green. Place the plate into the 1420 D instrument and
make sure that the plate is correctly oriented (the plate barcode facing the inside of the instrument). Close the lid and
press the instrument "Load" button.
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Wait for the measurement to complete, and remove the plate from the instrument.

Review the results using the Result Viewer software.
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About Result Viewer
Result Viewer is designed to allow viewing and effective management of assay results. The program is supplied for use
with PerkinElmer's 1420 D instrument.

Result Viewer allows you to browse assay runs and their histories as well as other related data in various ways. For a
particular assay run, you can then view the results of assays as well as information on calibrations and quality control
data.

Note: Result Viewer can be customized to individual laboratories' requirements. For this reason, the information you
will see on screen may sometimes differ from the illustrations in this manual.
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Starting up and structure of program

How to start Result Viewer
The program may be started from the program list of the Windows Start menu.

As the program opens, you will see a splash screen with the program's name and version number.

Assay console and result console
The display you then see is called the assay console. This allows you to browse assay
runs and their histories, and to find the specific information you need to work with.
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The Result console is used to look at specific data for the assay of interest. It opens from the assay console as a second
window. (How to open the result console is explained in Opening and navigating the result console on page 43).

After you have examined or approved a set of results, the result console is then closed, and you return to the assay
console window.

Note: Some of the functions shown in displays such as these may be disabled or hidden. This will depend on your
access rights.
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Structure of displays
Both the assay console and result console parts of the Result Viewer program have a consistent visual structure.
The following illustration shows the assay console, but the same components are also found on the result console.

The main components are a shortcut bar [A], a toolbar [B], a menu bar [C], a heading bar [D], and a main client area [E].

Clicking a shortcut icon on the shortcut bar will cause the selected information to be displayed in the client area.
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Reviewing Assay Runs

Navigating the assay console
We will briefly examine the shortcuts, toolbar buttons and menu items that are available for navigation, before
providing instructions on how to perform specific tasks using them.

Shortcuts
The assay console has two shortcut groups in the shortcut bar, the Work Flow group and the Special group.

By clicking shortcuts in the Work Flow group you see in the client area lists of assays being processed, awaiting
acceptance, or already accepted. The number of assays at each stage in the workflow is shown in brackets. For more
details see also Review of the workflow stages on page 38.

The Special group provides shortcuts to assays pending and to all specimens taken. There is also a specimen search
function.
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Toolbar buttons
Different toolbar buttons will be shown depending on whether you are viewing lists of assays, lists of specimens or
specimen search results. Below you can see the toolbar buttons that appear with assay lists. The buttons may be either

inactive or active. 

When it is active, the Open button can be used to open the result console (see Opening and navigating the result
console on page 43). The Assay Log button allows you to open a log dialog box (see How to view the assay log on
page 41). The Delete button allows you to delete an assay, while the Refresh button is used to update the screen with
changes that have not been automatically updated.

Menu items
There are five menus called File, Edit, View, Actions and Help. Under the File menu are items that allow you to open the
result console (see Opening and navigating the result console on page 43) print reports or exit the program. Under
the Edit menu are items to allow you to search for a particular assay or to delete an assay. The View menu provides
access to various logs and status lists, as well as to specimen search and screen refresh items.

Result Viewer
Reviewing Assay Runs

37



Review of the workflow stages
As mentioned above, the Work Flow short cut group includes short cuts to lists of the assays at various stages of the
workflow, Punched, At Worklist, Measured, Calculated and Accepted.

Punched shows the plates that have been created with Plate Generator (see Using Plate Generator on page 116)

At Worklist lists runs that have been created by using a worklist and have not yet been measured.

Measured plates have been measured but not yet calculated. Plates for which calculation fails will remain in this state.

Calculated assays are waiting for your acceptance.

Accepted assays are already accepted and an export file may have been generated. However, you can still view and
change them if needed.

Information on how to restore an assay to an earlier workflow stage is given under How to restore an assay to an
earlier workflow stage on page 57.

Finding a particular assay
Often when you need to find a particular assay, you already know the workflow stage where the assay is located. If this
is the case, you may find the assay by choosing the appropriate Work Flow shortcut and applying various filter options
to shorten the list of assays displayed. Alternatively, when you do not know the Work Flow stage, you can search for any
assay (see How to search for an assay at any workflow stage on page 39).

Filtering by date of assay
If you know roughly when an assay has been performed you can also use that knowledge to help find it.

Decide on the values for the first and the last dates on which you think the assay may have been performed

For each of the two fields, there are alternative ways of working.

Accept the date you see by checking the checkbox to the left of the date

or

Choose a new date in the drop-down calendar (or simply overtype the date you see)

A tick will automatically appear in the check box for the field.

Note: If either of the fields' check boxes is checked, but you do not wish the date limit to be applied in filtering the
assays, you can uncheck the box by mouse-clicking it.

How to shorten the assay list displayed
You can also limit the length of the list displayed on screen.

First click one of the column headings to place the list of assays in a known order

For example if you click "Date started" the assays will be listed in reverse chronological order

Then supply a new number in the List max length box.
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How to search for an assay at any workflow stage
To find an assay at any stage of the workflow, assuming you know certain details, you can find it quickly using the assay
search function.

1. Select the Search Assay item from the Edit menu

The search assay dialog that opens allows three alternative ID properties for searching an assay.

2. Choose one of the three search properties from the drop down menu
3. In the Search value: field, type in the particular Assay ID, Batch ID or Tag that you wish to search for

Click OK to start the search

If an assay can be found using criteria given, it will open in the result console.

Additional functions of Assay Console

How to view the request list

Instead of looking for a particular assay, you may wish to look for specimens for which an assay request has been
made.

1. Under the Special shortcut group choose the Request List shortcut

You will see a specimen list grid, and above this, a filter pane just under the heading bar.

The filters allow you to obtain a listing according to a particular test and/or a request type.
2. From the drop-down menus make the desired selection

The list obtained can be printed.
3. Choose the Print item from the File menu

The print preview box will open. For information on previewing options please see How to preview the print copy on
page 75.
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How to obtain full information on a specimen

You can obtain detailed information about any of the items on the request list by using the History button, which
becomes active when an item is selected.

1. Select the item of interest by clicking on it
2. Click the History button on the toolbar

You will then see the relevant specimen details in a display such as the following.

3. Click the View Assay button on the toolbar

This will open the assay in read only mode in the result console
4. To close the result console, select Close from the File menu or use the button marked with a cross in the top right

hand corner of the window (see also Exporting results to a file on page 58)
5. To close the Specimen History box after use click the Close button on the toolbar

How to search for a specimen

If you know the identity of a specimen (i.e. the barcode information for that specimen), a quicker way to obtain
information about it is to use the Specimen Search shortcut.
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1. Under the Special shortcut group choose the Specimen Search shortcut

2. In the Specimen code box, type the specimen ID
3. Click Search

When an assay is selected in the search results display the View Assay toolbar button will be active.
4. Click the View Assay button to open the assay in read only mode in the result console
5. To close the result console, select Close from the File menu or use the button marked with a cross in the top right

hand corner of the window (see also Exporting results to a file on page 58).

How to view the assay log

It may often be useful to review the run history for a particular assay. This may be done from both the assay console
and result console parts of the Result Viewer program. For instructions on viewing the assay log from the result
console, see Assay log on page 75. Directly from the assay console you can see the data log for any of the assays listed
at any of the Work Flow stages or under the Pending shortcut.

1. Select the assay of interest
2. Click the toolbar Assay Log button or click the Assay Log item under the View menu

3. After you have reviewed the assay history, close the box by clicking the close button in the top right hand corner

How to view the user log

In addition to viewing the assay log, you might also wish to review the actions of a particular user by opening the user
log.
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Click the User Log item under the View menu
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Viewing Results
The result console is used to view results for a particular assay, as well as the related calibration and quality control
data, which can also be edited. You can view the results in either plate view or grid view. The result console also allows
access to assay run logs.

Opening and navigating the result console
You can open the result console in various ways.

1. Highlight the assay of interest on the assay console.

The assay chosen may be on one of the assay lists, either a workflow stage or the Pending list found in the Special
shortcut group.

2. Click the Open button on the toolbar, or select the Open item from the File menu, or double click the highlighted
assay of interest on the assay console.

Note: In addition, there is also a view assay command on some of the views and dialogs. When you use these, the
result console is opened normally in read-only mode.

Navigating the result console
When you open the result console you will first see the assay results presented in plate view (see How to choose plate
view or grid view on page 44). Alternative shortcuts will be available under the Views shortcut group.

The View menu provides an alternative method of accessing the same shortcuts for the particular assay types.
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Result views

How to choose plate view or grid view
The two alternatives for viewing results, are grid view and plate view.

If you are in grid view and would like to change to plate view,

1. click the Plate button on the toolbar or select the Plate item from the View menu
2. To change back from plate view to grid view, click the Grid button on the toolbar or select the Grid item from the

View menu

To make your navigation smoother, the two views are synchronized. If you click a particular row in grid view, the
corresponding well will be selected in plate view. Also, if you select a control or a calibrator well, the corresponding QC
trace or calibration will be set as active so you will see it first when you enter a Calibration or QC view.
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Multilabel grid view
There are two different ways to display the result grid for multilabel assays: you can view data either as a single grid, or
as two separate grids.

When in single grid view, each analyte has its own column and you need to use the horizontal scrollbar to look for the
analyte you want.

When using the two separate grids, the left grid contains sample identification information. Selecting a row will bring
the corresponding analyte information in the right hand grid, where each analyte is displayed on its own row.

To choose the way you want to display the grid, click the icon in the upper right corner of the grid area. The first one
displays the data in a single grid, and the second in two separate grids.

Information available in grid view
Grid view is used to show and edit results, and it may be configured to suit your laboratory's needs. As a result, the
grids illustrated in this manual should be considered as examples. Their content may be similar but not identical to
those that you see.

Some of the commonly used column headings (that may not be self-explanatory) are listed below.

Code is the identification of the sample, such as the specimen barcode.

Role specifies whether the measured specimen is a calibrator, control or unknown. Sub role is then
a sub-category of Role such as calibrator order number.

Flag shows the most recent flag given. When this column is configured as editable, clicking it opens
a separate dialog where you can see all the flags and give a new one.

Result Status shows the QC status of the result. Red will cause repeat, yellow will prevent acceptance. The
column is not editable, because Flags are the appropriate control tools.

Status is the workflow status

Result code is the association of confirmation and follow-up logic. When this column is configured as
editable, clicking it opens a separate dialog where you can give a new value and a comment.

Determination level provides an interpretation of the measured value (Normal, Borderline, Presumptive Positive,
etc.).

How to configure grid view
If you have the appropriate user rights, you can perform the configuration of grid view by entering configuration mode

1. Drag the cursor onto the headings line of the grid and right click with the mouse

2. Select the Configure Layout item from the menu

The headings line of the grid will be highlighted in red to indicate configuration mode is selected.
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3. Obtain the context menu by right clicking on the grid

4. According to your configuration need, make your selection from the menu.

When in configuration mode you can resize and move columns by dragging them with the mouse. You can also delete
or edit existing columns or create new ones.

The New column item will cause a new column to be prepared on the right of the grid. The Properties item will show
you details of the currently selected column. Making either of these selections will cause the Column Properties dialog
box to open. If you instead choose the Delete column item, the currently selected column will be deleted.

The Exit configuration item allows you to save any changes made. You will be invited to supply a new name for the new
configuration and configuration mode will close.

Note: A layout name Default<something> cannot be overwritten, so you have to choose a different name. In this dialog
it is possible to select an alternative Print layout, for example Landscape, from Print script list.
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Column properties

In the Column Properties dialog box, the drop-down menu for the Column category allows you to select
or change the category of the column. The option chosen is determined by the nature of the Data source.

The Heading field contains the heading for the column. You can choose whether to include the test name, and if
applicable, the units of the data source.

Below are some examples of the configuration for some commonly used grid.

Plate Well Line Nr Code conc. µU/mL Result Code

Column
category

Position A01 position Inbuilt Inbuilt Field Answer

Data source Plate Well Line Code Conc Result code

Additional
data qualifier

Heading Plate Well Line Nr Code Conc Result Code

Include Test
name

X

Include Unit X

Alignment Right

For more details on columns, refer to Column formats for grids on page 77.

Once you have edited the Column Properties dialog, click OK

Save the configuration changes using the Exit Configuration item from the context sensitive menu

Note: If the grid does not refresh automatically, close the assay and then reopen.
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How to filter results in the grid
Under the heading bar in grid view there is a combo box which may allow you access to various methods of filtering the
results.

1. To select an existing filter, click the arrow next to the menu

2. Choose one of the drop down options

You can also set your own filter definitions using the results filter dialog.
3. Click the detail command button to the right of the combo box.

4. Either

Edit an existing filter and save it under its existing name or supply a new name (the old filter will be overwritten)

or

Click the New button and make your required selections
5. Click OK

If you need to see the actual numerical result without truncation to reporting limit add a new column to the result grid
(as explained under How to configure grid view on page 45) using the settings as shown below.
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The new column can then be dragged to its desired location, before you exit the configuration.

Upon Save, the layout cannot be stored under the original "DefaultResult", so you will need to give it a new name.

How to change the level of a control or calibrator in grid view
If you have inadvertently punched a control or calibrator from the wrong spot, the error is often caught after the plate
has been processed. Instead of reprocessing the plate or re-working the data files, you can instead swap controls or, if
necessary, change sample definitions from within Result Viewer.

You may need to check with your supervisor whether you have access rights to perform this function.

To swap two controls or calibrators

1. Open the result console for your assay and select grid view
2. Select two (hold down the "Ctrl" key while using the mouse to click on both specimens) controls or calibrators. If you

use controls, they must correspond to actual physical specimens as opposed to being calculated values.

With the specimens selected (highlighted), right-click the mouse and select Change Sample definition
3. The following pop-up will appear.
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4. Enter a reason for the operation and click OK

To swap all occurrences of these sample types

This function is relevant, for example, in an assay having multiple sets of controls.

1. Open the result console and select grid view
2. Select two wells containing controls (press the "Ctrl" key while selecting specimens with the mouse)
3. With the specimens selected (highlighted), right-click the mouse and select Change Sample Definition. The

following pop-up will appear.

4. Select the "Swap all occurrences of these Sample types" check box
5. Enter a reason for the operation and click OK

To change Sample Definitions

1. Open result console and select grid view
2. Select one or more specimens of the same type (such as controls or calibrators)
3. Right-click and select Change Sample Definition. The following pop-up will appear.

4. In the right-hand drop-down box, select the new specimen type
5. Enter a reason for the operation and click OK
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How to select a plate or well in plate view
Plate view allows you to view several plates at a time. You can adjust the number of plates on the display by making the
plate pane wider or narrower.

1. Mouse click on the right hand edge of the plates pane and drag the edge left or right. You can access any of the
wells in any of the plates.

2. If the samples are on more plates than you can see, use the mouse to drag down the side bar until the relevant
plate is displayed

3. Click the well of interest

The panes on the right will then show you information about the assay and test run, the plate that the selected well
is on, and the result for the well that is selected. If the selected well is part of a replicate group, then there is a fourth
pane that gives information on the average result of the replicates.

Color coding in plate view

There are three alternative ways you can view the wells. You can view them according to severity. This means the status
of the well, and the nature of flags associated with it. Alternatively you can view the wells according to sample role or
determination (see below).

In each of these a system of color coding is used to make the information about the role and status of each well clear.

Note: The colors and color coding shown in this manual are default settings.

1. To select one of the three alternatives, mouse click the arrow associated with the well colors field just under the
heading bar [A]

2. To view the color coding to interpret the plate map, click the button to the right of the well colors field [B]. The Color
Schema legends box will appear.
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3. When you have viewed the color codes, close the box by clicking the cross in the top right hand corner or the Close
button.

Here we have chosen to view the color coding for severity. As mentioned, you can also view plates according to the
sample role [A], that is whether the wells are occupied by controls, calibrators or unknown samples, etc. The third
alternative is to view plate according to the determination [B], in which the color of the wells containing unknown
samples relates to an interpretation of the measured value, that is, Normal, Borderline, Presumptive Positive, etc. These
lists may contain items not used in your edition of the software.

If you view a plate using either sample role or determination, the wells will change their color to accord with the
associated legends box.

About flags and severity
Possible problems with the assay, the plate or with the individual well are indicated by flags. Flags may be created
automatically or you can create them yourself. When you do this, any existing flags (associated with the same assay,
plate or well) will be ignored.
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Each flag associates with a severity level as shown here. The list is in order of severity. Info, OK and Notify permit
results to be released as they are.

If the assay, plate or well is Held, you will need to take some action before it can be released. Prevented means the
affected specimens need to be re-tested. Deleted means the result will be neither reported nor repeated.

Since an individual well may be subject to flags associated with the assay or with the plate as well as with the well
itself, situations sometimes arise where more than one flag applies. In these situations, the most severe flag is the
determining one.

You can add flags when working in either plate or grid view.

How to flag a well, a plate or an assay from plate view
1. Select the well, the plate or the assay to be flagged
2. To flag a well, click the detail (…) button on the right in the result pane. In case the selected well is part of a replicate

group you can flag the average result by clicking the detail (…) button on the right in the average pane.
3. To flag a plate, click the detail (…) button on the right in the plate pane.
4. To flag an assay, click the detail (…) button on the right in the assay pane.

The flags box that opens is similar, whether the flag, the well, the plate or the assay is to be flagged.

5. Specify a flag type from the drop-down menu
6. Specify a level of severity from the drop-down menu
7. Supply a comment
8. Click OK
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Note: The flag types from which you choose will be configured locally. Each flag type can be linked with a comment so
that you do not need to type the same comment every time you use the specified flag type.

How to flag results for individual analytes or analyte groups in multi-label
assays

In multi-label assays a flag can be applied to a single analyte, analyte group or all analytes of the assay run.

1. Open the flags box as described above (points 1 and 2 under How to flag a well, a plate or an assay from plate view
on page 53.

You will see that the box that opens when you are working with a multi-label assay includes an Apply to: field with
a drop down menu. The menu items are determined by the selections made for Analyte Group and Analyte in the
toolbar menu.

Note: If the assay is not a multi-label assay, the Apply to: field is not present in the Add Flag box. If you have not
specified any analyte group or analyte in the toolbar menus, the Apply to: field will be present, but inactive.

2. Choose the selected analyte, the analyte group or all analytes from the Apply to: menu

How to apply flags from grid view
1. Open the context menu by right-clicking on the selected line
2. Select Flag

The Add Flag box opens

3. Make appropriate selections in the flag box
4. Click OK

How to review details of previously applied flags
When you set a flag, you may wish to review details of flags that have been previously applied. This too is done in grid
view.

1. Click in the desired row in the Flag column
2. Click the detail command button that appears (...).

The flag dialog this time has a flag grid in the upper part of the window and in the lower part of the window there is
a frame for adding new flags.
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3. Make the appropriate selections of flag type and severity and add a comment if you wish
4. Click OK

Note: In multi-label assays the flag is applied to the single analyte from which the current flag column derives its data.
It is thus independent of the selection in the analyte group and analyte dropdown lists in the result console. If the Add
flag dialog is invoked from the popup menu (obtained by right clicking on any column), then the flag is applied to all
analytes of the current run and no flag grid is shown in the dialog.

Accepting an assay
Assays ready for your acceptance are listed and can be found by clicking the Calculated button on the Work Flow
shortcut bar.

How to accept an assay
1. Review the assay in the result console
2. Click the Accept button on the toolbar. Before actually executing the Accept command, the following informative

dialog will be shown if there is any information available.
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3. Click OK to confirm the accept command or click Cancel to cancel the accept command

How to recalculate a run
There are two ways to recalculate a run: Full calculation and Result code calculation only.

Full calculation calculates the entire assay as if it were just imported from the instrument. This means that the software
will:

1. Calculate the concentration for each specimen
2. Apply QC rules and QC flags (OK/Held/Prevented) for each specimen.
3. Rank the specimens for percentile-based cutoffs
4. Assign result codes
5. Recalculate assay statistics such as mean or median of Initials

In the Result code calculation only option, the software will perform only steps 3, 4, and 5 from the list above. Thus,
this option calculates new floating Cutoffs and ResultCodes but leaves the existing Assay Concentration values and QC
alone.

Note: Prevented results are excluded from assay statistics. Thus, if a specimen has a "QC Prevented" status when
the plate is first calculated, it will not be included in the statistics. If a user then changes the status to "QC OK," the
specimen will be used in statistics and therefore affect for example percentile cutoffs and mean of initials if those are
used by the assay that is calculated.

Assays may be recalculated as follows:

1. Click the Calculate button
2. Select either Full calculation or Result code calculation only
3. If performing full calculation, make sure that the specified kit lot number is correct. Depending on the assay

type and user level, the kit lot selection may be unavailable. When a kit lot number is specified the Result code
calculation only option becomes unavailable.
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4. Click OK to confirm the recalculate command or click Cancel to cancel the recalculate command

In the Work Flow shortcut group within assay console you can see groups of assays in various states of progress.

How to restore an assay to an earlier workflow stage
Depending on security rights and the state of the assay, the Restore Assay command may be available to restore the
assay to a lower state in the assay workflow. There are a number of possible reasons to do this.

Restoring Accepted to Calculated, for example, allows more editing and prevents the use of answers that are still
doubtful.

Restoring Worklist to Punched makes it possible to re-load the instrument with a different set of plates, possibly
rejecting some plates

Restoring Measured to Worklist also allows the use of new plates, but in the situation when import has already taken
place.

Restoring Calculated to Measured allows combining of a multiple plate assay in a different manner. Note that this
operation will discard any changes you have made to the assay.

Viewing or printing assay parameters
You can view a printable report on a particular assay run.

1. Select the Assay Parameters item from the View menu. The Assay Parameters window is displayed
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2. To print the report click Print or to close the box, click Close

Assay parameters for multi-label assays

If you are working with a multi-label assay and no single analyte is selected from drop down list in the toolbar (see
Navigating the result console on page 43) the assay parameters dialog will allow you to view just the assay specific
information.

Exporting results to a file
Assay results can be exported as a file to be used to transfer results to another software.

You can, if you wish, export the results automatically when an assay is accepted. Or you can manually perform the
export. In either case you just need to define the export format and the file location just once.

How to define the format of the export file
1. In the File menu select the View Assay Export... item.

A grid similar to result grid will open.

Define the required columns as described under Column properties on page 47, choosing an assay run which
includes the maximum number of analytes that you are measuring. If a run does not have all of these analytes, the
extra columns will be omitted.

Further configuration options are available from the Configure export dialog (see lower picture).
2. Open this by clicking the Options button.
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The default path to the folder where the file will be saved is shown in the Export path field.
3. Click the button to the right of the field if you wish to select or create a folder

4. Choose the file format. Choices are:

a. Delimited, generic format for external applications

b. CSV for Excel, specific Excel compliant format

c. MultiCalc, specific format emulating MultiCalc
5. Choose the file naming system for the assay run. The name of the assay run file can be ID, Name, BatchID or Tag

of AssayRun
6. Specify the file extension.
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7. Choose the list separator. The current local default is suggested but <tab> is also possible. The list separator in
Assay Export does not follow changes in regional settings of your Workstation PC. You must manually set the
separator from the export options screen.

8. Check the Write file header checkbox if you would like to write MultiCalc ID line header in the beginning of file
(MultiCalc format only).

9. Check the Write column header checkbox if you would like to have column headings
10. Non-Multicalc format:Check Create multiple lines for multi analyte if you want to configure only the 1st analyte,

and then have other analytes on separate lines. Remember to select one column as Inbuilt / Test Name (see
Column properties on page 47)

Multicalc format: Check Exclude Empty Rows to remove empty rows from the file. This has same effect as using
file type option 16 in MultiCalc.

11. Check Use . as decimal symbol if your regional settings use some other decimal symbol and you want a dot (.) in
the file.

12. Check Lock Column configuration if you wish to prevent accidental changes to the grid layout
13. Use a filter to limit the exported lines to those visible, for example as in the table below.

Filter meaning

Level=1 only individual results

Level=1; Role=3 Only individual patient results

UsedForAnswer=1 Only those patient rows which are marked as "Used For
Answer"

Role is expressed using a number code inside the export file. The number codes for the various roles are as shown in
the table below. It may contain items not used in your edition of the software.

# Role Used for

1 Calibrator To build Calibration curve

2 Control To store in QC for L-J plots and QCRules to check assay

3 Patient Normal sample

4 Proficiency External QC sample.

5 Reference For comparison only. Example unused Calibration sample due to copied
Curve

How to export a file manually
If, for example, you did not configure automatic export from the Automatic export Configuration dialog, you can
manually trigger the export.

Click the Export button.

Result Viewer
Viewing Results

60



How to export a file automatically
If you want the program to exort the file automatically when the run is accepted, open the Automatic Export
Configuration dialog by clicking the Automation button.

The Automatic export configuration window opens. It lets you choose which analytes are automatically exported and
in which format. You can choose up to 3 formats for each analyte.

Closing the result console
Normally the result console will close automatically after you have pressed the Accept toolbar button. As mentioned
earlier, however, the result console may be open in read-only mode. In this case, or if your security rights are limited,
the Accept button will be disabled.
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1. Select the Close item from the File menu or click the button marked with a cross in the top right hand corner of the
display

If you were in read-only mode, or if you were in write mode, but have made no changes, the result console will
close.

If there are any pending changes, the following dialog is shown.

2. Click Save, Discard or Cancel as appropriate

Calibration
Using the result console you can view the calibration graph for your assay of interest, zooming in for detailed
examination. You can also edit the curve, for example by toggling individual replicates on or off.

In the following example, by choosing the sample role option in plate view (see Color coding in plate view on page 51),
we can see that calibration samples have been measured in wells A1 to A12.

Click the Calibration shortcut on the Views shortcut bar

Assuming that curve fitting is successful, you will then see a plot of the calibration data.
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How to inspect values on the curve
You can read off the values at any position on the curve.

1. Click the Inspect button on the toolbar

The Inspect Unknowns box will appear in the middle of the display.

2. Either type a response value (e.g. a value for an unknown sample) in the upper of the two fields: The lower field will
then show you the concentration value for that concentration.

Or type a concentration value in the lower field

The upper field will show you the corresponding response.

Whichever field you type in, blue horizontal and vertical dotted lines will provide additional clarity by showing the
axes intercepts for both response and concentration.

How to view part of the calibration curve in detail
You may wish to take a closer view of the positions of individual points on the curve.

1. Click the Zoom button on the toolbar
2. Bring the cursor close to the area you wish to examine
3. With the mouse button held down, drag the mouse to create a rectangle bounded by a dotted line
4. Release the mouse button

You can repeat this procedure several times to allow as much detail as you wish. When you have completed your
examination you can return to the view of the whole curve as follows.

5. Click the Reset button on the toolbar

How to modify replicate points
Having viewed the curve and the positions of points, you can exclude any point that you deem to be too far off its
expected count value. Such a case may arise if you determine the incriminated point to be a replicate measurement
failure that should not be included in the curve fitting.

A

1. Click the Points button on the toolbar: The Modify replicate points box will then open.
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2. Click the box associated with any point you wish to omit from the curve fitting calculation

Following the modification of a point, the curve is automatically refitted. Any point that is "switched off" is marked
with an empty square.

Having examined the new curve, you may wish to return the omitted point to the curve fitting calculation.
3. Click the (now unchecked) box next to the point so that the box is checked.
4. When you are satisfied with the curve, click Close

You may, of course, re-open the Modify replicate points box, if you wish to make further changes.

How to view calibration properties
You can view the current definitions for the calibration in the Edit calibration dialog box.

Click the Edit button.

Note: If you wish to make changes to the settings, the Kitlot Editor module provides an easy to use tool.

The Edit calibration dialog consists of three sections under separate tabs.
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Under the first tab you see the calibration properties. Advanced properties are displayed only when the Show
advanced properties checkbox at the bottom of the dialog is checked.
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The fitting definitions tab page allows you to view initial fitting parameter values for the current calibration. The curve
fitting parameter values in this tab page are used whenever a new calibration under this fitting definition is created. At
the bottom right there is a frame showing the Display properties.
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The third tab is called Current Kitlot. This allows you to view the kit lot that is used by default when a new calibration is
created using the current fitting definition.

Quality control
Result Viewer allows you to view quality control data either in a table (grid), as a Levey-Jennings plot or as a histogram.

Note: For further information and background on quality control, refer to the main Quality Control part of this manual.

Click the shortcut button marked QC.

The form of the presentation you see first will be a Levey-Jennings plot. In this the points of the QC trace are presented
as a continuum ordered by run date.
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The material you view is chosen from a drop-down menu on the left, under the heading bar.

The rectangle with red edges shows you the selected QC run.

You can select an alternative method of presenting the information by clicking certain of the toolbar buttons.

How to view QC summary data
You can view summary quality control data for each of the control materials for a particular test.

Click the QC Summary button on the toolbar.
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How to view Levey-Jennings plots of QC data
To return to the Levey-Jennings plot click the LJ Plot button on the toolbar.

Note: For Multianalyte assays, you should create a special Analyte group with the name "AssayName"_QC, example
ABCD_QC if the assay is called ABCD. Only analytes in this group will go to QC and all lists and plots will be sorted by
this group.

Cursor forms

As you move the cursor onto the Levey-Jennings plot the form of the cursor will change. A crosshair cursor is seen when
it is brought near to a point (see Point information on page 71).

The "magnifying glass" cursor forms shown above are used when you want to zoom in on a particular part of the trace
(see Selecting part of a plot on page 70) . The alternative forms indicate the presence of an event [A] or of no event [B]
within a run (see Levey-Jennings plot options on page 69).

Levey-Jennings plot options

The Plot Options dialog box allows you to specify how the graph is presented.

To open this, click the Options button on the toolbar. The Plot options window is displayed.
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You can choose how you wish deleted points treated, whether you want to have vertical lines to indicate the beginning
of a run or other event (i.e. a kit lot change, a change of target or a change of SD Limit), whether you want the SD scale
constant or automatic (based on the amplitude of the plot), whether run dates will be included, and whether statistics
are to be included on the plot (see Viewing statistics on page 70).

When you are satisfied with your selections click Apply or OK

The Apply button allows you to save the new filter settings while keeping the dialog box open. Clicking OK will save any
changes made, but will also close the dialog box. Clicking Cancel will close the dialog box (without saving any changes
made since you last clicked Apply or OK).

Viewing statistics

Whether you are viewing QC information as a Levey-Jennings plot, or in another type of presentation, you can opt to
have statistical data on screen below the main plot.

On the bottom left of the Plot Options dialog box, check Show Statistics

The statistics consist of the count, mean, SD and CV% for all points, selected points (see further) and the plotting limits.

Selecting part of a plot

The mouse pointer changes to the shape of a magnifying glass when you draw it over the plot, indicating the possibility
to zoom in. You can zoom in to view any part of the plot in greater detail.

Using the mouse, select the desired area including those points you want to see under magnification.

Release the mouse button.

Note that the mean and SD are calculated and presented as count statistics under Selected Points.

After studying part of the plot in detail, you may wish to return to viewing the complete plot.
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Either, right mouse-click somewhere on the plot and select Zoom Out from the drop-down menu , or click the Reset
button on the toolbar

Filtering data

You can limit the plot to a selected part of the total data by clicking the Filter button on the toolbar to open the Filter
QC Data dialog box.

Note: Filter settings are always used. After setup of the program the default setting is the last 200 points.

Point information

You can obtain detailed information on any plotted point.

Place the cursor on the point and click with the mouse.

The resulting QC point information box provides information on the point, on rule violations, and on the severity of the
violation.
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Note editing, together with QC point activation/deactivation are not possible for the QC points of the currently open
Assay run in Result Viewer. These functions are therefore disabled. Run, plate, and point flags are read from the assay
system.

Click the View Flags… button.

Result Viewer
Viewing Results

72



How to view histogram plots of QC data
You can view a histogram of the points for the selected level or trace on the basis of their z-score, i.e. the number of
standard deviations the points are from the target.

1. Click the Histogram button on the toolbar.

The Histogram tab of the Plot Options dialog box allows you to specify how the histogram is presented.
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2. Click the Options button on the toolbar. The Plot Options window is displayed.

In the same way as with the Levey-Jennings plot, you can view statistics on screen by checking the Show statistics
box in the Plot options dialog box. You can also filter data as described under Filtering data on page 71. You can also
view the histogram for the points in a selected region of the trace.

3. Return to the Levey-Jenning plot by clicking the LJPlot button
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4. Select part of the Levey-Jennings plot as described under Selecting part of a plot on page 70
5. Click the Histogram button

You will then see the histogram for just the part of the trace that you selected.
6. To return to the complete histogram, click the LJPlot button and then the Histogram button

How to view/export points data
In grid view you can see a table of the points comprising the level or trace selected.

1. Click the Grid button on the toolbar

As with the other plot presentation modes, you can view statistics on screen by checking the Show statistics box in
the Plot options dialog box. You can also filter data, and view the grid for just part of the trace.

If you wish to export data, you first write the data to a tab separated text file, which can then be opened in the
spreadsheet program.

2. Gather the data you wish to export onto the display
3. Click the Export button

Assay log
Earlier (see How to view the assay log on page 41) we reviewed the use of the assay log feature from the assay console.
You can also see all relevant information on the history of an assay from the result console.

If you want to view the assay log from the result console, click the Assay Log shortcut on the shortcut bar and the assay
log box will appear.

Assay printing

How to print a hard copy
Whether you are working with the assay console or the result console, options are available to allow you to print paper
copies of the information you see on screen. Although, under certain circumstances toolbar buttons may be available
for print commands, the commands are always available under the File menu.

1. In the assay console, use the Print item (from the File menu) to print a complete list of the assays shown. Use Print
Current View to print just what you see on screen

2. In the result console, use the Print Assay item (from the File menu) to obtain a report. Use Print Current View to
print just what you see on screen.

The two main printing options you can choose from are thus a complete list or report of what you are viewing, or a
screen dump of what is currently on the display. In the Quality Control part of the program, a third printing option
exists. If you want to have a hard copy of a plot, for example, a Levey-Jennings plot you can print just the trace.

3. Choose the Print Trace item (from the File menu) to obtain a printout of the trace currently showing in the client
area

How to preview the print copy
For all print options except Print Current View, you can preview what the printout will look like.

1. Select (for example) the Print Assay… item from the File menu.

You will be shown the print preview display.
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There are navigation buttons [A] allowing you to view the first page, the next page, the previous page or the last
page of the item you are printing.

After these four navigation buttons, there is the confirm print button [B] followed by page setup button [C], which
allows you to choose the printer, paper size, etc. Then there are zoom buttons [D], which allow you to enlarge or
reduce the size of the report. On the right of the toolbar is a write to PDF button [E], which allows you to save the
printout as a PDF file.
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Additional information
The following parts contain additional information on result viewer functions.

Column formats for grids
Note: The grid referred to is the Result Viewer Grid view. For more on this, refer to Column properties on page 47.

Column Category = Inbuilt
Under this selection you may specify data source as follows.

• Data Source = Flag, shows topmost flag. The flag column cannot be edited, but it will always give a cell button to
open the flag dialog for all related flags. Optionally, the flag column can show single flag type only. Flag types are
customizable

• Data source = Line, is a sequential number, showing default sort order of the grid
• Data source = Role is like Calibrator/Control/Patient.
• Data source = Sub role is index 1.. within Role, like calibrator order number
• Data source = Code is identification of Sample, like Specimen barcode
• Data source = Used for answer is needed when the assay has replicates. Only one value average or one of

replicates can be used to give the value for the answer. Should be set editable when used.
• Data source = Result Status shows QC status of result. Red will cause repeat, Yellow will prevent accepting.

Column is non editable, because Flags are tools to control this. Use BackColor on this column.
• Data source = Test Name is Name of TestRunDef. This is mainly to do one line per Label Exports
• Data source = Target Conc is coded Conc for Calibrators and Target for Controls. Requires one column per Label.

Useful in Export only
• Data source = PAT is a sequence number for the patient samples in this assay, starting from 1.

Column Category = Field
Data source is the name of a field. Some fields are always available like Conc and Counts. Fields are output data and
cannot be edited.

Additional data qualifier:

• <empty> - legacy mode, CV% in same cell as Mean
• Text - mean w/o CV%
• CV% - empty on individual, CV% on avg rows
• Unit - main unit on every row
• Value - precise value, number of decimals need to be set per column

Column Category = Position
Data source is the name of a dimension on Sample position, like Plate. The value shown is an integer.

Column Category = Position A01
Data source is the name of a combination dimension like Well. The value shown is in text format, such as A01.
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Column Category = Measurement
Data source is measurement index 1.. within a Sample. This should be used when measurements are no connected
directly to specific and field, but are always imported in same order.

Column Category = Named Measurement
Data source is the name of TestRunDef, which is equivalent to Assay in single labeled measurements. The next
selection is Field name like Counts, CountsB. Only those names that are found inside the current Assay run are
available. To show all possible names, like when configuring for manual entry, select first "Measurement", set editable,
then select "Named Measurement".

Column Category = Answer
This shows properties of this Assay Answer(s). In MultiLabel assays you also need to select which Test.

Calibrators and controls do not have any info on column. Most needed items:

• Data source = Value plain, shows calculated value without rounding or limiting it. Default format can be applied to
remove extra decimals. If the column is editable then altering the value will recalculate ResultCode

• Data source = Value Text is to be reported value. Also this can be made editable
• Data source = Result Code has confirmation and follow-up logic attached. Editing is allowed, but only with cell

button and a dialog. In the dialog you need to give the reason for the result code override. Reasons are Flags with
Context = E (rEesult code) selected.

• Data source = Determination level gives quick estimate on positive/negative respect
• Data source = Status is workflow status.
• Data source = TestPhase shows Initial/Retest/Recall
• Data source = Related will be 0 to 100 as percentile when percent limits are used
• Data source = Previous shows possible earlier ValueText from same Specimen and Test
• Data source = Delta from Previous is ValuePlain minus earlier ValuePlain
• Data source = Avg with previous is mean ValuePlain and earlier Answer
• Data source = CV% with previous is non weighted CV% ValuePlain and earlier Answer

Column Category = Another Test
Gives same functionality as own answer from any Test. Actual Test Name must be selected in DataSource and then
Answer like sub selection in Additional data qualifier.

Column Category = Specimen
Calibrators and controls do not have any info on column. Most needed items:

• Data source = ExtCode1,2,3 different ways to identify specimen, ExtCode1 usually barcode
• Specimen Quality shows status like UNSAT
• Specimen Category shows Normal/Proficiency or other what have been programmed

Column Category = SpecimenDetail
On LifeCycle database SpecimenDetails can be aliased and made visible to Result Viewer. Data Source can be selected
from aliased names. Example "Age at collection". No editing allowed
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How concentrations are determined
Curve fitting is used to calculate results in the software. Calibrators of known concentration are measured. The
measured counts (Y-axis) are plotted against the known concentration values (X-axis).

These points are fitted using either the linear regression or Spline curve fitting method.

The concentration of a sample of unknown concentration is determined from the intercept of its measured value with
the calibration curve.

For more information on the nonlinear regression method see the following references.

Bates, D. M, and Watts, D. G. Nonlinear Regression and Its Applications. NewYork: Wiley, 1988.
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Gill, P. R., Murray, W., and Wright, M. H. "The Levenberg-Marquardt Method." §4.7.3 in Practical Optimization. London:
Academic Press, pp. 136-137, 1981.

Madsen, K., Nielsen, H.B., and Tingleff, O. Methods for Non-Linear Least Square Problems, Technical University of
Denmark, 2004

The Spline method is described in the following work.

Yrjönen, T. RIA-standardikäyrän määrääminen splinefunktion avulla. Luk-tutkielma, Turun yliopisto, Fysikaalisten tieteiden
laitos, Fysiikka, 1981.

List of flags used in Result Viewer and assay printout
Flag name Description

Expired QC Material System flag to notify user about expired QC Material

Kitlot Expired System flag to notify user about expired kit lot

Expiration date not given Kit lot or QC material expiration date not defined

Condition Information about parameters that have to match for all plates in an assay

Instrument Instrument-given information about an error that has stopped plate measurement

Instrument warning Instrument-given notifications related to single well information and possible errors

Curve Copied Flag informing which calibration is used for the plate

Bad Curve Calibration curve has more than one turning point

Amb? Concentration value cannot be resolved from the calibration curve

No-Fit Calibration curve fitting failed

HH Concentration is higher than the defined reporting limit

LL Concentration is lower than the defined reporting limit

CV Concentration CV% of replicates exceeds defined limit

QC Quality control rule violation

Reject Calibration point is excluded from curve fitting

ResultCode Edit Automatically added flag showing user override of result code

Sample changed Automatically added flag showing user override of Sample type or level

Pre-QC User-given flag to repeat sample before measurement.

FreeText Free text flag for the user to give

DELTA CV% calculated from Initial and Confirmation exceeds given "Delta CV% Limit"
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About Quality Control

Purpose
Wallac Quality Control is a program designed to allow effective management of quality control data in screening or
diagnostics laboratories. The program is designed to suit all of the assay types and all of the measuring technologies
employed in today's laboratories.

Assay quality control is based on the measuring of control samples. Although specific rules on how this is done will be
set by individual laboratories, a typical practice might be to run different control samples in duplicate on every plate.
Wallac Quality Control allows you to store and review results for the control materials employed, and provides various
different plot options to allow monitoring of the quality control levels associated with the quality control materials.

Wallac Quality Control includes information on all quality control run definitions, quality control materials and quality
control multirules used at your laboratory. The meaning of these terms and some other key concepts are explained in
the table on the facing page.

Use of the program involves specifying a quality control material and assigning it to a quality control level.

Successive tests based on the quality control material result in a sequence of data points which form a trace.

Components of the quality control level are then the trace for a particular quality control material, a multirule, a target
value and an expected standard deviation.

To support multi-label assays, the program allows simultaneous editing of multiple traces.

The target value and the expected standard deviation (SDLimit) of the level can be based on the actual mean of the
trace or any value set by the user.

Quality Control
About Quality Control

82



How to start up Wallac Quality Control
The program may be started in different ways. The one you will use will depend largely on the configurations that your
laboratory has implemented.

1. Start the program from the start menu of programs on your computer.

As the program opens, you will see briefly the program's splash screen where the program's name and version
number are displayed.

The first screen image that you then see will be the same as that which was active when the program was last
closed. (See, for example, the display on Purpose on page 82.)
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Navigation

Structure of the program
The Wallac Quality Control program has a consistent visual structure that will be familiar to users of Microsoft
programs. The main components of each of the displays (see picture below) are a shortcut bar [A], a menu bar [B], a
toolbar [C], a heading bar [D], the Navigation Tree [E], and a main client area [F].

Clicking an item either within the Navigation Tree or on the shortcut bar will cause the selected information to be
displayed in the client area.

The Navigation Tree is used for finding and selecting any item, be it a QC run definition, material or multirule.

In practice, most users will not need regular access to most of the items found under the Navigation Tree. To make
things easy, you can create shortcuts to just those items that you require and place them on the shortcut bar together
with, or to replace those already supplied. You can also create a new shortcut group to supplement the existing one
that is marked QC. The Navigation Tree can then be closed, to provide a more conveniently large client area.

Navigation Tree
If the Navigation Tree is not visible on the screen, it can be opened from the View menu (see How to close or open the
Navigation Tree on page 85 for details).

In the illustrations below, on the left hand side we see the Navigation Tree with all branches closed.
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Next to each closed branches is a box containing a plus sign [A]. This symbol tells us that a branch containing more
information is available. Clicking the plus sign next to, for example, Assay Run Definitions, gives us a full list of the
definitions. Again, plus signs are found next to most of them. Clicking an analyte shows a list of levels or traces
associated with it. When the branch is open, the symbol inside the box changes from plus to minus. If we click the
minus sign the branch closes and the minus sign turns back to plus. Any or all of the available branches may be open at
the same time.

Note: For multilabel assays there is an additional level to the tree, so selecting such an assay gives a list of analytes.
The level or trace is then specified for each of these.

How to close or open the Navigation Tree
You may wish to close the Navigation Tree.

Either,

1. Click the cross next to Navigation Tree

Or,

1. Click the Navigation Tree item under the View menu (so that the tick next to the item disappears)

To open or reopen the Navigation Tree

1. Click the Navigation Tree item under the View menu (so that a tick appears next to the item)

Shortcuts
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How to create a shortcut
You can create a shortcut in a number of different ways.

Either,

1. Select an item in the Navigation Tree to which you would like to have a shortcut
2. Drag it over to the shortcut bar

Or,

1. Right click the item in the Navigation Tree
2. Select New shortcut from the dropdown menu

Or (for example, if the Navigation Tree is closed),

1. Right click somewhere inside the shortcut bar
2. Select New Shortcut from the extended dropdown menu
3. From the tree that appears, select the item to which you would like to have a shortcut

How to create a shortcut group
1. Right click somewhere inside the shortcut bar
2. Select New Group from the extended dropdown menu
3. Supply a name for the new shortcut group

How to delete a shortcut or shortcut group
You may wish to tidy up your desktop by deleting those shortcuts that you no longer use.

1. Right mouse click the shortcut button that you wish to remove and select Delete From Shortcut Bar

2. Select Delete From Shortcut Bar

How to close or open the shortcut bar
You may work with the shortcut bar or the Navigation Tree or, if you wish, both of them open.

To close or open the shortcut bar,

1. Click the Shortcut Bar item under the View menu (see previous picture)

A tick will appear next to the Shortcut Bar item when the shortcut bar is open.

Toolbar buttons for navigation
On the left of the toolbar are two buttons concerned with navigation. They are marked Back and Forward.
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Note: Any of these two buttons might be disabled, depending on your locality and local settings.

Use of the Back and Forward buttons will be intuitive to anyone familiar with web browser programs.

1. To return to the previous display you had on screen, click Back
2. To continue to scroll backwards continue to click Back

Note: The Forward button will be inactive until Back has been used.
3. To return to the point you were at before you clicked Back, or to revert to any intermediate display, click Forward.

Other toolbar buttons
The toolbar also contains a number of other buttons that may vary to some extent, depending on the phase of your
work.

They will allow you to perform functions such as saving and printing, or select different ways of presenting or plotting
the quality control information. These functions will be described in the following section of the manual.
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Main functions
As has been explained, the basis of assay quality control is the monitoring of the level of a quality control sample. This
section describes the main functions of the Wallac Quality Control program, and starts with an explanation of how a
quality control level is defined.

Configuration of QC levels
Defining a QC level involves specifying a trace, a multirule and limits. These specifications are made using the
Configuration display, which also allows editing of both QC levels and traces.

1. Click the Config button on the toolbar

In the Navigation Tree (If you do not see the Navigation Tree please see How to close or open the Navigation Tree on
page 85 for instructions on how to turn it on) you will see a list of QC Levels.

2. Select the name of the QC level you wish to define

Note: You can enter the names of new QC levels in connection with QC run definition (see following section), and
these names will appear here.

How to select the trace
You select the trace using the middle pane of the Level configuration display (Configuration of QC levels on page 88).
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1. Click somewhere in the Trace line [A]

A dialog for the trace selection then appears.

2. Click the arrow next to the item that is marked here "Traces without levels connected to NTSH" in the dialog box

A menu will drop down allowing you to choose one of four different lists that can be used for the selection:

• Traces without level connected to current QC run definition
• Traces connected to current level
• All traces connected to current QC Run definition
• All other QC materials

3. Choose one of these lists

4. Choose one of the traces shown on the list

Note: It is important to remember that a trace will not be recognized by the system as a trace unless it has results
associated with it. A "trace" that has been named, but for which no results have been recorded will appear only in
the "All other QC materials" listing.

After the trace is selected the SDLimit and Target can be set in the lower pane of the Level configuration display [B].
5. Right click to add limit or simply enter new values to replace existing ones
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Other selections needed
The multirule is selected from the dropdown menu at the top of the upper right pane of the Configuration display
(shown on Configuration of QC levels on page 88).

Assay run definition
If you click the Assay Run Definitions shortcut button on the list bar, you will see in the Navigation Tree a list of the
names of the definitions. The list you see is read only, since the assay run definitions inherit their basic properties from
test run definitions that are defined using a different program.

You can view the levels and traces associated with any of the QC run definitions.

1. Click the plus sign next to the Assay run definition name.

To obtain more information you need to enter item mode.
2. Select the name of the assay run definition (NTSH).
3. Select the name of the analyte that you are concerned with.

How to add a new QC level
In item mode the client area is split into two. In the upper section there is a list of the QC levels defined for the selected
assay run definition. The run ID is selected from a dropdown list on the toolbar.
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This list in the upper pane is editable and new QC levels can be added simply by inserting the name of the new level
into the empty row. Initially this row is the lowest one.

1. Scroll down to the bottom of the list
2. Type a name for the new level in the empty bottom row
3. Supply a description (depending on your configuration, you may see additional field headers besides Description.

If so, supply details of the level relevant for these fields).

How to edit a QC level
The basic properties (i.e. name, description, etc) of a single QC level can be edited directly by typing into the table.

Note, however, that the level configuration settings of trace, target and SD limit cannot be entered here. To define
these you need to use the configuration menu as described under Configuration of QC levels on page 88.

In the lower section of the run definition display there is a grid showing the latest run and points data.

The Level column includes both QC levels and QC trace names. Traces are identified by their material name, which is
written in brackets.
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Point is a running number for each QC Run.

Value is the calculated concentration.

Z-score is the number of standard deviations by which the point value differs from the target. In addition to the
numerical values in this column, a colored bar in one of the next two columns (+ or -) provides an easy to assimilate
method of viewing the sign and magnitude of Z-scores. The longer the bar, the greater the value. The bar is red for
values greater than +3 SD and smaller than -3 SD. Otherwise it is green.

Note: The Z-score is calculated based on the set limits that were used in defining the level, not on the standard
deviations of the measured points.

Flags refer to a possible rule violation of the point.

Note: Only one rule violation is described. Should there be more than one violation, the most critical violation is
described.

2SD Range shows the range of values covered by 2 standard deviations. Values for 2SD Range (and for Target, not
shown in the picture above) are based on the limits attached to the trace at the time of calculation

The Notes field allows the user to supply a short text.

QC Materials
If you click the QC Materials shortcut button on the list bar, you will see a list of the names of QC materials.

How to enter a new QC material
You can enter the name of a new material as follows.

1. Type a name for the new material into the bottom row in the table.

2. Supply properties of the material (the display name, and a description, if required)

The properties of the new material can then be entered.
3. Enter item mode by clicking the QC material's name in the Navigation Tree
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QC Multirules
You can view the currently available multirules by clicking the QC Multirules shortcut button, or by clicking the QC
Multirules item in the Navigation Tree.

You will see a list of the available multirules in the client area on the right side of the display. The Navigation Tree
also allows you to view the names of the multirules within the Navigation Tree by clicking the plus sign next to QC
Multirules there.

As with QC run definitions and QC materials, you can add a new multirule by typing its name in the bottom line of the
table. You can provide a description of the multirule here in list mode, but to enter more information go to item mode
by clicking the name of the rule either in the Navigation Tree or in the client area.
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The Rule Editor is opened by double-clicking an individual
rule or by selecting Edit from the right mouse click menu
of an individual rule.

A new rule can also be created by right mouse clicking in an empty space in the lower part of the client area.

There are four basic rule types, with each rule based on a specified number of points and/or a Z-score value.

The fourth of the rule types (as listed in the Rule Editor dialog box, shown above) also allows you to choose both figures
to express the proportion of points over the specified z-score value.

The scope of the rule defines the period for which data is taken into consideration when applying the rule.

The scope may encompass just the frame (normally the
microplate currently being measured), the run or the
entire level.

An indication of the severity of any violation of the
specified rule is also given.

Saving and refreshing functions

How to save changes to database
As you work with Wallac Quality Control, you
will edit information drawn from database. The
changes you make will not become active until
you update the database by manually saving
the changes.

Whenever there are no unsaved changes, the Save button on the toolbar is disabled. As soon as you enter or change a
data item, the Save button will be activated.

To save data,
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1. Click the Save button or choose the Save item from
the File menu.

Like the Save button on the toolbar, the Save item in
the File menu is enabled only when changes have been
made, but not yet saved.

How to update the display
The refresh function involves re-reading data from the
database.

1. Click the Refresh button on the toolbar

Clicking Refresh will also ensure that the program is updated with any new QC results that have been obtained.

Printing

How to take a hard copy of a plot
At any time you can take a printout of what you see on screen. You might wish to print the entire client area.

1. Select Print Current View from the File menu

If you have a plot, for example, a Levey-Jennings plot
on screen, and just want to have a hard copy of that,
you can print just the trace.

2. Select Print Trace

How to print according to a defined report format
As an alternative to printing the current view, you can print LJ Plots, Histograms and Grids according to a specified
report format.

1. From the File menu choose the Print item

Existing defined printing formats are listed in the Print box that appears. The highlighted definition is summarized
below, under Report description.

2. If you want to edit the definition or start from scratch in creating a new one, click either the Edit or New report
button

The appropriate dialog box opens to allow you to edit or create a new print definition.
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3. Supply a name and description for the new print definition (if you are creating a new one)
4. Choose which run definitions the printout should refer to
5. Apply base and/or plot filters
6. Click OK
7. Confirm the changes by clicking Yes. The Edit Print Definition dialog box closes
8. In the Print box with the appropriate definition selected, click Print

You will next be shown a print preview.
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In the toolbar are navigation buttons [A] allowing you to view the first page, the next page, the previous page or the
last page of the item you are printing.

After these four navigation buttons, there is a Print button [B] followed by a Page setup button [C] which allows
you to choose the printer, paper size, etc. Then there are Zoom buttons [D], which allow you to enlarge or reduce
the size of the report. Towards the right of the toolbar is a Write to PDF button [E], which allows you to save the
printout as a PDF file.

How to save or delete a print definition
If you have created a new print definition it will have been saved once you approved it by clicking OK.

1. To delete a definition, select it and click the Delete button
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Plot options for QC levels and QC traces
So far we have seen summary information on specific runs (as defined by the Run ID code). Now we will turn our
attention to presentations that allow us to see complete information for QC levels and QC traces.

1. Click on a particular level or trace from the Navigation Tree

In the illustration above, there are levels in the Navigation Tree marked ED20, ED50 and so on.
Levels and traces are distinguished by their icons. QC levels appear as in the pictures above and
upper right. QC levels may be distinguished from QC traces by the icon that appears next to them.
QC traces appear as in the picture lower right.

For both levels and traces, the information may be presented in the form of Levey-Jennings plot,
histogram or grid. The form of the presentation you see first will depend on the active setting, i.e.
you will see the same type of presentation as you were viewing when you last examined levels
or traces. Whatever the presentation in the client area, the toolbar will include buttons as shown
below.

The toolbar looks the same for both levels and traces, apart from the Config button. Here it is shown active, but it will
always be inactive with traces.

How to view Levey-Jennings plots of QC data
By clicking the LJ Plot button on the toolbar, you can get to see a Levey-Jennings plot of the points comprising the level
or trace selected.
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If the current trace has more than one limit, the LJ Plot scale can be selected from the drop-down list in the upper right
corner.

Either click the Options button on the toolbar or right mouse click somewhere in the pane that contains the plot and
then click the context menu item, Options.

The Plot Options dialog box opens. This allows you to specify how the graph is presented.

You can choose how you wish deleted points treated, whether you want to have vertical lines to indicate the beginning
of a run or other event (i.e. a kit lot change, a change of target or a change of SDLimit), whether you want to show
units, and what the SD scale should be, whether run dates will be included, and whether statistics are to be included on
the plot.
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Previous trace

When feasible the points from a QC level's previous trace are shown before the present active one. In this situation the
previous trace is shown in grey.

Where there have been several previous traces, you can view any particular one of them.

1. Place the cursor near a point of interest of the QC level's previous traces
2. Right mouse-click and choose Focus to Trace

You will see that the trace of interest is now blue, and all other parts of the QV level are reduced to grey.

How to view statistics
Whether you are viewing QC information as a Levey-Jennings plot, or in another type of presentation, you can opt to
have statistical data on screen below the main plot.

1. On the bottom left of the Plot Options dialog box, check Show Statistics.

Statistics may be toggled on or off using this check box on the Plot Options dialog box.

How to limit a plot to view selected data
You can limit the plot to a selected part of the total data.

1. Click the Filter button on the toolbar to open the Filter QC Data dialog box.

There is a choice of five settings for the base filter. You can choose to view data for a specified number of months
from any starting date, for the current period (day, week, month, year, etc.), for a period between specified dates,
for previous periods, or for the period up to the present.

2. Check the appropriate button
3. Make selections of time period, starting date or number of days (according to your choice at point 2)
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In addition to the base filter you may wish to apply a plot filter to limit either the number of points or the number of
runs.

4. Check the Plot filter checkbox
5. Check one of the buttons below it to choose either number of points or number of runs
6. According to your choice (at point 5) specify the number of points or runs you wish to include
7. If you would like to retain new settings you have made, check the Save as default filter checkbox.
8. Click the Apply button to save the new filter settings while keeping the dialog box open.

or

Click OK to save the changes and close the dialog box

Note: Clicking Cancel allows you to close the dialog box without saving any changes made since you last clicked Apply
or OK.

Note: Filter settings are always used. After setup of the program the default setting is the last 200 points.

How to view points and run information
You can obtain detailed information on any plotted point.

1. Place the cursor on the point

When you do this, a gray circle will appear around the point

2. Click inside this circle with the mouse.

The resulting QC Point Information box provides information on the point, on rule violations, and on the severity of
the violation. On the lower right of the box, is a Point is active check box. Unchecking this box will allow you to view
the plot without the presence of this point. The point will also then be excluded from statistics.
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You can enter notes relating to a single QC point. The area for the notes is divided into two parts, the upper part for
inserting new notes and the lower part for possible previous notes. If you add a new note, when you click OK, the
application adds your user name and a time stamp to the note. Changes are not permanently saved, however, until
you click the Save button in the main application window.

3. Click the View Flags... button.

The QC Point Flags box appears, showing all assay system flags, i.e. the Run flags, Plate flags, and Point flags.
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4. After viewing the flags, close the box by clicking Close
5. Exit the QC Point Information dialog by clicking OK or Cancel
6. To obtain run information, move the mouse pointer near the axis [A]

The axis line will become highlighted.

The most usual situation in which you will want to find out more about the run will be when there have been events
relevant to QC such as a kit lot change or the setting of a new target or limit for a trace. An event such as this is
marked by a blue vertical line.

7. Click the axis to open the QC Run Information with Events dialog

How to select part of a plot
You can zoom in to view any part of the plot in greater detail.

1. Using the mouse, select the desired area including those points you want to see under magnification

The cursor form will change as you do this.
2. Release the mouse button. Note that the mean and SD are calculated and presented as count statistics under

Selected Points.
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After studying part of the plot in detail, you may wish to
return to viewing the complete plot.

Either,
3. Right mouse-click somewhere on the plot
4. Selecting Zoom Out from the drop-down menu.

Or,
5. Click the Reset button on the toolbar.

How to view histogram plots of QC data
By clicking the Historgram button on the toolbar, you are able to view a histogram of the points for the level or trace
selected grouped on the basis of their z-score, i.e. the number of standard deviations the points are from the target.

1. Click the Histogram button on the toolbar.

The Histogram tab of the Plot Options dialog box allows you to specify how the histogram is presented.
2. To open it click the Options button on the toolbar or right mouse click somewhere in the pane that contains the

plot, and then click the context menu item, Options

You can specify the number and size of the bars and whether or not statistics will be shown by checking the Show
statistics checkbox (in the same way as with the Levey-Jennings plot).
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If you have selected points by zooming in on part of the plot (in other words, "All points" differs from "Selected points"),
the bar data refers to the selected points, but an envelope is drawn indicating the values for all points.

You can also filter data, and view the histogram for just part of the trace (see How to select part of a plot on page 103).

How to view/export points data
By clicking the Grid button on the toolbar, you are able to view a table of the points comprising the level or trace
selected. As with the other plot presentation modes, you can view statistics on screen by checking the Show statistics
box in the Plot options dialog box. You can also view filtered data, as well as the grid for just part of the trace (see How
to select part of a plot on page 103).
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Exporting data

The points data can be exported either to an MS Excel compatible file (.csv file) or to a text file with tabs as separators.

1. Click the Export button on the toolbar.

2. Provide a file name and a path on your computer or network selecting the file type from the Save as type options if
needed.

3. Click Save.

Purging data
The purge data tool allows viewing of QC data and configurations, and purging of those items no longer required.

1. Under the Tools menu, select Purge Data

In the dialog box that opens there are four tabbed panes.
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2. Click on the appropriate tab - Levels, Runs, Materials, or Traces
3. If you have chosen Levels or Materials, make a further selection of the type of material for purging from the

dropdown list in the upper part of the dialog.

The following selections are accessible via the different tabbed panes:

• Levels marked as deleted
• Levels with no traces
• Materials marked as deleted without traces
• Materials marked as deleted with traces but no points
• Runs with no points
• Traces with no points
• Traces with points

4. Select individual items in the chosen list by checking the checkbox in the Purge column.

If you want to deselect an already checked box, you can also do this by clicking it, and you can select or deselect all of
the checkboxes by clicking the Select All or Deselect All button, near to bottom of the pane.

When you have selected all items to be purged, click the Purge button.

Only those items that are checked in the Purge column in the selected list will be removed. Clicking the Close button
will simply close the dialog without removing any items.

Using the trace editor
The trace editor tool allows activation of, and limit setting for a number of traces at a time.

1. Under the Tools menu, select Trace editor
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The Trace editor will open.

2. To find the relevant traces, select the relevant assay run definition (or choose All)
3. Click to the right of the time period box [A] if you wish to modify the period over which the traces are presented.

4. In the Filter QC Data box that opens, specify the desired time period
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5. Click OK

The trace editor allows you to do four things. You can activate traces, edit active traces, adjust limits, and edit
trace statuses. The upper part of the display page allows you to choose which one, and the lower part of the page
then shows you a grid of data relevant to the selection you made. In each of the grids, the columns that have bold
font headers are editable.

6. To sort the data in the grid, simply click on any of the column headers

How to activate new traces
1. Check the Activate Traces button

Within the grid you will see a list of those traces that are attached to a level but are not yet set to be active.

2. Select the traces that you want to activate by checking the checkbox in the Activate Trace column

The Editable Target and Editable SD Limit columns show the calculated values from the existing QC points.
3. Edit these values as needed

When you do this, the Add limit checkbox will become checked.
4. Click the Apply button to accept the new values

Note: When adding new limits both target and SD values must be supplied before the Add Limit checkbox can be
checked. Also the newly edited values are validated so that if both values are the same as current limits values, the Add
Limit checkbox cannot be checked.

How to edit active traces
1. To review the traces that are already active, check Edit Active Traces.
2. If you wish to specify limits you can modify either or both of target and SD values

The checkbox in the Add Limit column will automatically become checked.
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Note: The instrument column shows whether the values in the Editable Target and Editable SD Limit columns are
from instrument specific limits (instrument name), a common limit, or from calculated QC point values.

3. Click the Apply button to accept the new values

How to adjust limits
You may wish to compare the targets and SD values from limits to the calculated mean and SD values from samples.

1. To do this, check Adjust Limits
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The Current Target and Current SD Limit columns show currently set limits. Target diff % and SD Limit diff %
columns show you the difference, as a percentage, between calculated and set values.

The Values from column shows the number of samples used for calculation. The Editable Target and Editable SD
Limit columns are initially filled with calculated values.

2. Edit these rightmost columns if you wish to save new limits.

The checkbox in the Add Limit column will automatically become checked.
3. Click the Apply button to accept the new values

How to edit trace statuses
You may wish to change the status of a trace.

1. To do this, check Edit Trace Statuses

The Current status column shows you whether the trace is currently New, Active or Retired.

New means that trace is not yet used as active trace for the level. A level can have only one active trace at a time.

Retired refers to a trace that is no longer of interest for quality control.
2. For the trace that you want to change the status of, check one of the blank checkboxes

The check box that was formerly checked for that trace will become unchecked, but the current status itself does not
change until the new setting has been applied or saved.
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Unlike the grids shown for the other tasks performed using the trace editor, the Edit Trace Statuses grid also lists
those traces that are not yet assigned to any level. A trace not assigned to a level is always shown as New and its
status cannot be changed until the level has been set.

If you wish, you can make trace-level connections or even change current attachments directly from this grid.
3. Click in the Level column for a particular trace

You will get a dropdown list of the Levels of the QC Run definition of the trace you selected.
4. Make or change the selection by clicking the respective level in the menu.

Similarly, you can select or change the multirule for a level.
5. Click in the Multirule column for a particular trace

The dropdown list that appears will include all multirules in the QC system.
6. Make or change the selection by clicking the respective level in the menu

For all changes made using the Edit Trace Statuses grid the font for the status that is to be changed will appear in
bold.

7. Click the Apply button to accept the new values, or if you have finished working with the Trace Editor, click Close

With both the Apply and Close buttons a message box asks you to confirm that your wish to save or cancel the
changes you have made.

For general information on multiple trace activation, see also Multiple trace and limit activation on page 112.

Multiple trace and limit activation

A new material should not be used for QC until the user activates it and sets limits. The user can select a control
material by choosing one that is not activated yet and named in the form, "*-*". All traces linked to this material and
other materials that have a common front part in their name are offered for possible activation. For each trace current
mean and SD are suggested as limits.

Physical control materials are individual cards each having a unique barcode. Control cards belonging to the same lot
will have a common Control Lot number as part of its barcode. As an example the Control Lot number may be the
bolded part of the total barcode on an example card:

Q12345601004857
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One card may have multiple levels. If the example card above consisted of Low, Medium and High controls, these levels
would be identified, respectively as:

123456-1

123456-2

123456-3

This naming system is used by punchers and should be followed with any kitlot entry program.

Single level cards will not have the level postfix.

If the name of a QC level matches a control sample name in the assay configuration, then newly created traces will
automatically be linked to the level.
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Using Plate Generator

Plate Generator is a separate application that provides additional functions to generate plate information manually for
VICTOR² D when the plates are not already generated from worklists or through connected punchers.

How to generate a plate
1. Enter barcode and click the Enter barcode button.

Note: A barcode scanner should be used to read in barcodes if possible.

If the plate barcode you entered already exists in the database and it is still in punched state, the program will
display the following message.

2. Select the assay from the dropdown list.

The dropdown list from the Plate number field will then be filled with appropriate plate numbers, which are
independent plates.

3. Select plate number among predefined plate definitions.
4. Enter First sample code and number of samples and possibly Replicate. Number of samples will be automatically

restricted to fit on current plate.
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Confirm this selection with "Add samples". Sample codes are generated sequentially. Filled Wells are turned dark
green and have Tooltip to show their code.

This operation can be done multiple times with almost any codes. However, code should end with numbers to
allow sequential numbering; otherwise, generated codes will be longer to have incrementing number.

If you have barcoded samples and a barcode scanner connected to your PC, you can use the scan mode. In this
mode you assign the sample identifiers to the wells by reading the barcodes one by one. If scan mode is activated
then the number of samples setting is always 1.

5. On entering number of samples, insertion point is indicated with selected Well. It is possible to change insertion
point or remove specific Samples.

6. Earlier QC failed and Confirmation samples can be added from list. Select Samples and press tall left arrow button.

Initials - pre-entered to system, validation use only

Failed Initials - assay deleted or result flagged red

Retests - confirmation

Failed Retests - confirmation that was rejected

Each group shows replicate like (x 2). User entered replicate has no effect in this case.
7. If this plate is last of assay will have unused wells, then press Complete partial plate to attach possible End

Controls and mark rest of Wells Empty.

8. At any time, it is possible to see currently selected samples in a linear list. To close list use X in top right corner.
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9. Check the Print box if you wish to have the plate layout printed automatically when it is generated.

The checkbox will retain either its checked or unchecked state as default when you prepare future plates.
10. Optionally edit plate map by clicking on the desired well so that a list appears.

You can also select a block of several wells by keeping the mouse button depressed and moving the cursor over
the wells.

11. Make a selection from list and the plate map will be updated accordingly.
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12. When all editing is done click the following:

• click Complete partial plate if the plate has still free wells. This will place End Controls starting from the next
free patient Well and make the rest of the plate <empty>

• click Generate after the plate is complete
13. Click OK and the main form will be reset.

14. If plate generation is not desired now, but filling is desired from beginning, then select <Empty> on whole plate to
activate barcode enter again.

15. After all plates are generated, Close program.
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List of keyboard shortcuts
Control type Press To

General TAB Move forward through options.

SHIFT+TAB Move backward through options.

Dialog box ALT+access key Select or carry out the corresponding
command or control.

ENTER Carry out the default command of
the dialog box or command of the
selected control.

SPACE Toggle the selection status or carry
out the selected option or control
command.

Arrow keys Move focus or selection in a group of
controls or items.

Tab control CTRL + TAB Move forward through tabs.

CTRL + SHIFT+TAB Move backward through tabs.

CTRL + PAGE DOWN Move forward through tabs (same as
CTRL+TAB).

CTRL + PAGE UP Move backward through tabs (same
as CTRL+SHIFT+TAB).

Arrow keys Move between tabs when focusing on
the control.

Combo box F4 Display or hide the items in the active
list.

ALT + DOWN or UP Display or hide the items in the active
list (same as F4).

Any printable key or keys Moves the selection to the item
matching prefix letters in the
beginning of title.

List view SPACE Locates new selection and anchor for
the item.

SHIFT+SPACE Extends the selection from anchor to
the item.

CTRL+SPACE Invoke additional selection or
deselection and move the anchor to
the selected item.

Arrow keys Move focus and remove all selection
and the anchor previously made.

CTRL+arrow keys Move focus without move of selection
or the anchor.

Any printable key or keys Moves the selection to the item
matching prefix letters in the
beginning of the label.

CTRL + "+" (numeric pad) Adjusts the width of all columns to fit
their contents.

Tree view * (Numpad) Display all sub-items under the
selected item.

+ (Numpad) Display sub-items directly under the
selected item.
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Control type Press To

- (Numpad) Collapse the items directly under the
selected item group.

RIGHT ARROW Display sub-items directly under the
selected item (same as +).

LEFT ARROW Collapse the selected item group and
move focus to the group leaf root.

CTRL+UP ARROW Scroll the view without change of the
selection.

CTRL+DOWN ARROW Scroll the view without change of the
selection.

Any printable key or keys Moves the selection to the item
matching prefix letters in the
beginning of title.

Date and time picker F4 Display calendar below the control.

ALT+DOWN Display calendar below the control.

ALT+UP Hide calendar below the control.

PAGE UP Move to next month in the calendar.

PAGE DOWN Move to previous month in the
calendar.

CTRL+PAGE UP Move to next year in the calendar.

CTRL+PAGE DOWN Move to previous year in the calendar.

Check box SPACE Toggles the selected option.

- Clear the option.

+ Select the option.

Slider Arrow keys Move the slider to the next value.

PAGE UP and DOWN Move the slider to next value in
specified incremental amount.

Data grids CTRL-C Copy current cell as text

CTRL-SHIFT-C Copy currently selected cells as text

CTRL-SHIFT-ALT-C Copy the whole grid as text

CTRL-SHIFT-H Copy the whole grid as html

CTRL-Print Screen Copy the whole grid as bitmap

CTRL-P Print the whole grid in portrait mode

CTRL-ALT-P Print the whole grid in landscape
mode

Edit Box Shortcut Keys
Press To

HOME Move cursor to beginning of the line.

END Move cursor to end of the line.

CTRL+A Select all.

CTRL + RIGHT or LEFT ARROW Move cursor to the beginning of the next or previous
word.
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Press To

CTRL + DOWN or UP ARROW Move cursor to the beginning of the next or previous
paragraph.

CTRL+HOME Move cursor to the top of the document.

CTRL+END Move cursor to the end of the document.

Holding SHIFT + cursor movement (arrow, HOME, or END
keys)

Select or extend the selection.

Holding SHIFT + CTRL + Cursor movement Select or extend the selection by words or block of text.

INSERT Toggle the insertion mode.

Menu Controls Shortcut Keys
Press To

ALT+SPACE Display shortcut menu for the active window.

ALT+"-" (Hyphen) Display shortcut menu for the active child window (MDI
application).

ALT Activate the menu bar and enter menu mode.

F10 Activate the menu bar and enter menu mode (same as
ALT).

ALT+(access keys on menu or dialog box selected) Activate the menu bar and open corresponding menu to
the access key.

Access key [Menu mode] Carry out the corresponding command.

DOWN ARROW [Menu mode] Open menu item, move to the one item
below, or move to top of menu if focus is located in the
bottom of the menu.

UP ARROW [Menu mode] Move to the one menu item above, or move
to the bottom if focus is located in the top of the menu.

RIGHT ARROW [Menu mode] Open the next menu to the right, or open a
submenu.

LEFT ARROW [Menu mode] Open the next menu to the left, or close a
submenu.
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Configuration Based on Kit Inserts
Factory made Analytes are preconfigured to be according to Kit insert. After Calculation it is possible to view fitting
definitions. On Cloned assays SGPowerUser may have right to edit fitting definitions.

In the software , FIA means Down and IFMA up.

FIA assays have TOTAL or REFER to indicate that point is not on Curve instead it is part of Y-scaling.

Comparison of curve fitting terminology
Property Kit insert with MultiCalc Workstation

FITTING METHOD SPLINE SMOOTHED Spline

FITTING METHOD REGR LINEAR LinRegr

X-AXIS LINEAR or LIN None

X-AXIS LOGARITHMIC Logarithmic (Blank in use or
Calibrator A concentration > 0)

Hyperbolic (when 0 is plotted, Total or
Refer used)

Y-AXIS B/B max Bound/Max

Y-AXIS LOG_B LogB

Y-AXIS MEAS None

ASSAY TYPE (curve direction) FIA Down

ASSAY TYPE (curve direction) IFMA Up

First calibrator Role
First Calibrator is numeric, BLANK, TOTAL or REFER, Special parameter chooses how to deal with it:

• Blank - forces first calibrator to be treated as Blank, Counts are subtracted form other Calibrators
• Extrapolation - point is used for scaling, not part of part of actual curve fitting. Usually Total or Refer
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• Fitting point - point is fitted, need to be numerical value

Correction Calibrators
In Kitlot Editor it is possible configure location of each Calibrator and especially on 2nd plate setting position of
correction calibrators or use same plate map as 1st plate. If a plate has only some of Calibrators, then the Reference
curve is the earlier full curve in same assay, but if not available then reference Curve user must set earlier for each
Kitlot. In Kit insert there could be something like this

To use Correction calibrators Curve Fitting must have configured with Adjust method: Constant or Linear
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